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Executive Summary 

As part of the National Park Service (NPS) Inventory and Monitoring (I&M) program, a 
project was initiated in 1995 to develop a Natural Resource Bibliography (NRBIB) database for 
33 national parks in the I&M program in the National Capital Region and the Chesapeake and 
Allegheny clusters of the Northeast Region. The primary goal of this project was to create a 
computer-based annotated bibliography and supportive cataloging information for all materials 
related to the natural resources of each park. A secondary goal was to update the thesaurus or list 
of subject terms that has been used for all other NRBIB projects in the NPS. 

Personnel at The Pennsylvania State University and North Carolina State University 
divided the parks in the National Capital Region and the Chesapeake and Allegheny clusters of 
the Northeast Region geographically and worked on each separately but cooperatively. The 
project commenced in August 1995 and was completed by October 1997. ProCite bibliographic 
software was used to compile the bibliographic databases. 

The NRBIB database targeted all reports and other published or unpublished materials, 
including memoranda, photographs, maps, and museum specimens, which contained information 
about natural resources of a park and its immediate area. The primary sources of information 
were housed within the parks, but the NPS Denver Service Center Technical Information Center 
database and commercial citation databases were also searched for relevant materials. After data 
entry was completed for each park, subject terms were added to the database, using the NRBIB 
thesaurus as a reference. Terms not found in the thesaurus were periodically added to it. After 
editing the database, project personnel delivered it to a given park and conducted ProCite 
training. 

No national plan is currently in place to provide for ongoing database maintenance, but 
the University of Idaho is investigating potential strategies for this. Because NRBIB projects 
were distributed among a variety of universities and agencies, coordination at the national level 
was sporadic, which made it difficult to standardize data entry practices and share information. 
Records containing sensitive species information are not an important issue at this point, but may 
become so if the databases are made publicly available. An attempt was made to collect 
Geographic Information System (GIS) metadata along with NRBIB data at one park. This met 
with moderate success but was not conducted elsewhere due to project time constraints. If the 
NRBIB database is to have continuing value, provisions for continual maintenance and updating, 
as well as Internet access to the NPS-wide database, are crucial. Combinations of GIS metadata 
collection and NRBIB updating should be considered in the ongoing database maintenance 
effort. 
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Introduction 

As part of the National Park Service (NPS) Inventory and Monitbring (I&M) program, an 
initiative was begun in 1992 to develop a Natural Resource Bibliography (NRBIB) database for 
all national parks in the I&M program. This report is the final report of the NRBIB project in the 
National Capital Region and the Chesapeake and Aliegheny clusters of the Northeast Region 
(formerly Mid-Atlantic Region). I 

The primary goal of this project was to create a computer-based annotated bibliography 
and supportive cataloging information for all materials related to the natural resources of the 33 
parks designated for inclusion in the project. A secondary goal was to u1date the thesaurus or 
list of subject terms, which has been used for all other NRBIB projects in the NPS, as well as 
develop a separate thesaurus with terms for use only in the two project r6gions. The resultant 
bibliographies, associated ProCite software, and thesaurus were provide 

I 
to each park, to the 

cluster support offices, and to the Servicewide NRBIB project leaders at the University ofldaho. 
In order to compile the databases and the thesaurus, cooperative , greements were 

established between the NPS and both The Pennsylvania State University (PSU) and North 
Carolina State University (NCSU). Personnel at the two universities divided the workload of 
parks primarily according to geographic location and worked sebarately but cooperatively 

I 

(Tables 1-2). The project commenced in August 1995 and was completed by October 1997. 
Database and thesaurus products were shared between the two groups; this final report is a 
compilation of both efforts. 

Database Development 

Software 

ProCite bibliographic software was used to compile the bibliographic databases. ProCite 
is a software package designed for management of library resources. It allows for storage of 
bibliographic citations of the material as well as related cataloging information such as the 
document location, appearance of the item, subject matter terms, and catalog number. ProCite 
contains 26 predefined workforms specific to each document type (e.g., book,journal, report) 
and also allows creation of user.:defined workforms. This project used only predefined ProCite 
workforms. 

Copies of ProCite originally purchased for each park in this project were the DOS 
Version (2.1). In November 1995, a Windows version (3.1-3.4) became available, and parks 
were offered this version as an alternative if their computers were Windows-based. Databases 
can easily be converted from the DOS version to the Windows version, although some features 
are lost in the conversion from Windows to DOS. The Windows version allows for quicker 
searching, easier browsing, World Wide Web referencing, and enhanced editing capabilities but 
requires increased hard disk space. The Windows version is still being refined by ProCite, and 
updated versions have been made available to registered users. The version of ProCite installed 
at each park is indicated in Appendix A. 
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Table 1. Name, code, number of database records, and university responsible for each park 
included in the NRBIB project for the Northeast Region, 1995-1997. 

No. University 
Name Code Records Responsible' 

Allegheny Portage Railroad NHS / ALPO/JOFL 45 PSU 
Johnstown Flood NM 

Appomattox Courthouse NHP APCO 82 NCSU 

Assateague Island NS ASIS 639 NCSU 

Booker T. Washington NM BOWA 49 NCSU 

Colonial NHP COLO 607 NCSU 

Delaware Water Gap NRA DEWA 2009 PSU 

Fredericksburg and Spotsylvania NMP FRSP 200 NCSU 

Fort Necessity NB FONE 192 PSU 

Friendship Hill NHS FRHI 264 PSU 

George Washington Birthplace NM/ GEWA/THST 127 NCSU 
Thomas Stone NHS 

Gettysburg NMP I Eisenhower NHS GETT/EISE 927 PSU 

Hopewell Furnace NHS HOFU 215 PSU 

New River Gorge NR / Bluestone NSR / NERI/BLUE 402 NCSU 
Gauley River NRA /GARI 

Petersburg NB PETE 91 NCSU 

Richmond NB RICH 139 NCSU 

Shenandoah NP SHEN 2803 PSU 

Upper Delaware SRR UPDE 1543 PSU 

Valley Forge NHP VAFO 271 PSU 

1PSU = The Pennsylvania State University, NCSU = North Carolina State University 
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Table 2. Name, code, number of database records, and university responsible for each park 
included in the NRBIB project for the National Capital Region, 1995-1 · 97. 

No. University 
Name Code !Records Responsible1 

Antietam NB ANTI 166 PSU 

Catoctin Mountain Park CATO 381 PSU 

Chesapeake and Ohio Canal NHP CHOH 999 PSU 

George Washington MP GWMP 319 NCSU 

Greenbelt Park GREE 109 NCSU 

Harpers Ferry NHP HAFE 144 NCSU 

Manassas NBP MANA 167 NCSU 

National Capital Parks-East NACE 394 PSU 

Prince William Forest Park PRWI 261 NCSU 

Rock Creek Park ROCR 385 PSU 

1PSU = The Pennsylvania State University, NCSU = North Carolina State University 
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ProCite was designed fot personal collections and has many useful features for 
bibliographic record management; however, it can be difficult to use without introductory 
training. Therefore, as part of the installation and delivery of the final database, interested 
personnel at each park were given hands-on training in the use of the software. This also served 
as an opportunity for the project staff to further explain the goals and products of the project and 
encourage park staff to use and update their database. As shortcuts to the lengthy ProCite 
manuals, project staff developed training handouts with simple steps to adding records, 
searching, editing, and printing bibliographies (Appendix B). 

Initial Staff Training and Coordination 

In October 1995, project staff from both universities met in Fredericksburg, Virginia, to 
plan the approach to the project and discuss use of the ProCite software. Ms. Marilyn Ostergren 
from the Southwest Region NRBIB project trained the staff in the NRBIB ProCite format and 
suggested approaches to information acquisition and common problem situations. Data entry 
format and project procedures were thus standardized for both regions. At this meeting, parks 
were divided between the two staff groups as well. Finally, prior to beginning data acquisition at 
the parks, a letter was sent to each park introducing park staff to the goals and procedures of the 
NRBIB project. 

Scope and Acquisition of Information 

The NRBIB database targeted all reports and other published or unpublished materials, 
including memoranda, photographs, maps, computer data files or databases, and museum 
specimens, which contained information about the natural resources of a park and its immediate 
area. Natural resources in this case included flora, fauna, soil, air, water, geological features, and 
the factors affecting them, such as mining, grazing, pollution, and recreation. Materials that were 
general in scope and lacked specific reference to the park were not included in the database. 

The primary sources of documents entered into the databases were contained within the 
park itself. Typical document locations included resource management office libraries and files, 
park libraries, and administrative files. Preliminary searches were concentrated in the resource 
management offices. Other offices, such as nature centers and administrative buildings, were 
searched as time permitted. Often, references pertaining to research in another park were found. 
They were entered into a database for the appropriate park. Additional documents were also 
found by searching the citation lists of research reports. Documents not yet encountered were 
entered into the database as "citation only" and upgraded if and when the actual document was 
located. An additional source of park documents was the University Park, Pennsylvania office of 
the Chief Scientist for The Philadelphia Support Office. The Center for Urban Ecology of the 
National Capital Region, Washington, D.C., was not searched because of time constraints but 
could potentially house pertinent documents. An effort to catalog their materials is being 
conducted separately from this project. 

Project staff searched for additional published materials using major natural resource­
related commercial bibliographic databases, including Biological Abstracts, Wildlife and 
Fisheries Review, Fish and Fisheries Worldwide, CARL UnCover, Agricola, CAB, GeoRef, 
GEOBASE, Selected Water Resources Abstracts, Oceanographic and Marine Resources, Tree 
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CD, and Wildlife Worldwide. The citations added to the databases in this way were flagged 
"citation only" in the Notes field. Because the nwnber of citations obtaiped this way was fairly 
low, cut and paste functions were used to transfer citations froJ a word processing docwnent 
into ProCite. In conducting these searches, NCSU staff attempted to locate journals containing 
articles from the "citation only" records and to provide copies 9f these articles to the park 
involved. They were able to provide articles for approximately 50% ohhe records labelled 
originally as "citation only." 

The final source of materials was the Technical Information Center (TIC) database 
located in the NPS Denver Service Center in Denver, ColoradoJ The TIC maintains a database 
of their collection of maps and documents and theoretically all work produced by the NPS. A 
program developed for the NRBIB project converts TIC records into a fqrmat that can be 
imported into ProCite to more easily search for pertinent docunients. 

A common challenge ofNRBIB projects across the country has been managing the time 
spent searching for documents while trying to produce a comprehensive ~atabase as efficiently as 
possible. Many of the parks visited were in transition between personnel or office buildings, 
resulting in a general disarray of collections. The database project attempted to be as detailed as 
possible in these situations, while recognizing that docwnent locations '"fere likely to change 
over time. In these aprks, it was particularly important to encourage participation of the park 
staff in maintaining the database. Some parks decided to use the NRBIB database as an 
organizational tool for relocating or reorganizing their collections. 

Editing of Databases 

Prior to installing a database at a park, the NRBIB staff carefully examined it for errors 
from the data entry process. Some errors, such as misspellings and inaccurate citations, occurred 
in the original docwnent and could not be changed. Records obtained from different locations 
could be repetitive, but ProCite is capable of locating duplicate records to speed the editing 
process. Project staff attempted to minimize spelling errors, especially in the author, title, and 
keyword fields, thereby improving search capabilities across records. ProCite does not have 
spell-checking capabilities, but lists of entries can be created with the indexing feature. This list 
can then be manually searched for errors or loaded into a word processor program for spell­
checking. Lists of author names also were manually scanned to search for discrepancies. 
Finally, the list of subject terms was checked to ensure that it was consistent with the existing 
thesaurus in spelling and word use. New terms were added to the thesaurus as needed. 

Thesaurus Maintenance and Development 

A primary use ofNRBIB databases is to search for related docwnents using subject 
terms. ProCite has a separate field for subject terms ("Descriptors" in DOS version, "Keywords" 
in Windows version), which enables more powerful searching capabilities than searching for 
keywords in titles. There is no limit to the number of subject terms in a given record, and 
searches on subject terms can search across multiple records. Thus, it is important to use a 
standardized list of subject terms, referred to as a thesaurus, for all records in the NRBIB project. 
The thesaurus lists subject terms and includes cross references and scope notes to lead data entry 
personnel and users of the database to the most appropriate term or terms. 
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The NRBIB thesaurus started from a core list of terms used in the bibliographic effort of 
the Pacific Northwest Region. During the completion of the Southwest Region NRBIB project, 
the thesaurus was expanded, reviewed, and continually updated. Terms generated by the 
Northeast and National Capital regions' project were reviewed and added to the NPS-wide 
thesaurus. 

As regional terms and species names continued to accrue in the NPS-wide thesaurus, it 
became increasingly unwieldy for general use (a printed version in IO point font is 786 pages 
long and growing). For this project, the PSU team decided to retain a copy of the thesaurus 
terms used in the Northeast and National Capital regions for a more regional thesaurus. All 
terms used in the databases from the PSU half of the project were included in the regional 
thesaurus. Any of these terms that were new to the NPS-wide thesaurus were sent for addition to 
the comprehensive NPS-wide thesaurus. Mr. Scott Tiffney continually updated the regional 
thesaurus, adding cross references and term descriptions where necessary. Species names were 
confirmed with authoritative sources {Appendix C). When the parks received their final 
database, they received a printed copy of the regional thesaurus as well. The NCSU team did not 
compile a regional thesaurus, but trained park personnel in the use of the NPS-wide thesaurus as 
a Windows help file. Accessing the thesaurus as a help file provided fast and easy searching and 
a source for cutting and pasting terms into ProCite. Because the regional thesaurus was created 
merely for the convenience of the parks visited by the PSU team, the lack of inclusion of terms 
from NCSU did not cause a problem. 

Database Delivery 

Park Installation 

When a park database was edited and all information sources were searched and 
compiled, the final database was installed at the park along with the ProCite software. At this 
time, the project staff member introduced the park resource management staff to the database and 
trained them in use of ProCite. The training usually consisted of verbal instructions 
accompanied by written instructions (Appendix B) for basic tasks, such as searching, editing, 
adding records, and printing bibliographies. Most parks designated one or two staff members to 
learn how to use the database, but some requested that larger groups be trained. Small groups 
were preferred so that the trainee could sit at the computer and carry out instructions for hands­
on expenence. 

A challenge of the project was to persuade park personnel that their NRBIB database 
could be a time-saving device, rather than another demand on already limited time and personnel. 
Most of the parks with significant natural resources quickly understood the application of their 
ProCite database in locating documents in their collections, creating subject bibliographies, and 
cataloging information not held by the park. The value of the database was not as obvious, 
however, at parks where the primary emphasis was on cultural resources or where only a few 
natural resource documents are generated each year. Personnel at each park were encouraged 
during the training process to use ProCite for other resource management activities, such as 
report bibliographies and general document collections. Another method to improve ProCite 
user skills was to recommend the use of ProCite to document other collections, such as cultural 

resources or law enforcement. 
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Database Maintenance 

Maintenance of the database will involve adding new records that are consistent with 
I 

existing records, modifying records to reflect changes such as new locat~ons, and redistributing 
updated versions. Without an individual in the support office dfsignated to provide support and 
encouragement, this will be difficult to achieve consistently within all parks. However, during 
installation and training, park staff were encouraged to take on the task o1f maintaining the 
database. As discussed above, some parks appeared more receptive to the use and maintenance 
of the database than others, which could lead to an uneven distribution of maintenance efforts 
among parks. I 

At the completion of the project, parks were contacted and requested to send any database 
updates to the project staff. This reminder may have encouraged a small effort at database 
maintenance. Periodic repetition of this request by someone at the support office may help 
continue the maintenance effort and ensure that the database is being used and maintained at 
many levels. I 

Service-wide NRBIB project staff at the University of Idaho are in the process of drafting 
an agreement that would make provisions for continuing financial and personnel support for 
database maintenance. Possible methods include "circuit-riding" data entry personnel who 
would periodically visit parks to input new information, park personnel uploading new records 
into the national database, or support office data entry coordinators. 

Problem Issues And Other Project Directions 

Project Coordination 

The involvement of personnel at various universities throughout the country was an 
effective means of completing the NRBIB projects, but the lack of central coordination 
occasionally created difficulties in sharing and standardization of information. The NCSU team 
relied heavily on the advice of Ms. Marilyn Ostergren, who manages the NPS-wide thesaurus 
and has been working on NRBIB projects in the western U.S. since 1993. Even with the level of 
interaction that occurred among Ms. Ostergren, PSU, and NCSU, the final databases from PSU 
and NCSU differed slightly in format (e.g., capitalization in titles). On a service-wide basis, 
there may be other discrepancies among the databases. Although the immediate goal of the 
project has been database creation (i.e., each park has a database of its natural resource 
materials), a secondary goal has been the creation of a NPS-wide database. This database could 
be used in a variety of ways: by personnel at a given park to learn how others have handled 
common problems, by researchers looking for potential projects; or by related government 
agencies (e.g., U.S. Forest Service, U.S. Environmental Protection Agency). 

NPS-wide Database 

The NRBIB represents a vast resource of research information that could benefit the 
greatest number of users if publicly available, for example, on the Internet. Mr. Richard 
Aroksaar of the NPS Pacific Northwest Region is in the process of determining the most 
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effective means of adding various ProCite databases to the Internet. Once this process is 
available, NRBIB staff plan to put an NPS-wide database on the Internet as well. 

Networking Updates 

Maintenance and updating of the NRBIB databases will become more problematic as the 
databases become available to multiple users at different locations. At the completion of this 
project, each database will be housed by the park, at least one support office, and The University 
of Idaho. If a park adds or changes records, these changes need to be made on the other copies of 
thee database as well. The creation of a NPS-wide database will expand this problem. NRBIB 
staff are currently recommending that semi-annual updates to the databases be coordinated by the 
support offices. Any new records added by the parks can be added to the other copies of the 
database. In cases where existing records have been edited, a copy of the entire database will 
have to be sent as an update. 

Sensitive Document Issues 

As data entry progressed, several parks expressed concern that public availability of 
research information could negatively impact sensitive (e.g., endangered) species and sites in 
parks. NRBIB database records and their abstracts, however, generally do not contain specific 
location information, though this information may be contained in the original materials. 
Because parks reserve the right to withhold sensitive species information from the public, it will 
be the responsibility of resource managers to determine accessability to complete documents. 
Nevertheless, some park managers felt that records referring to sensitive species would be 
problematic, because they document the existence of these species in the park. For example, 
personnel at many parks were concerned about records confirming the existence of American 
ginseng (Panax quinquefolius), a plant subject to extractive poaching, within the park 
boundaries. In some parks, controversial materials were withheld from the database, but the park 
staff kept a separate catalog of them for their own records. Before compilation of a NPS-wide 
database or public availability of the database, such as on the Internet, records concerning 
sensitive species could be flagged so that their existence is noted at the local database level but is 
omitted from the NPS-wide database. 

GIS Metadata 

The NCSU team experimented with combining NRBIB data entry with compilation of 
Geographic Information System (GIS) metadata while visiting Assateague Island National 
Seashore. Executive Order 12906, "Coordinating Geographic Data Acquisition and Access: The 
National Spatial D .. ta Infrastructure," requires federal agencies to use the Standard for Digital 
Geospatial Metadata to document data produced in 1995 and later. Legacy data (data produced 
before 1995) are not subject to the standard; but because the pre-1995 metadata are still valuable, 
the earlier data were cataloged as well. ProCite was originally examined as a potential vehicle 
for metadata entry, but ProCite workforms are limited to 45 fields, which are too few for even 
the simplest post-1995 metadata template. Metadata were instead entered into templates created 
using standard word processing software. Because ProCite and the NRBIB standards did not 
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prove useful for metadata entry at Assateague Island National SeashoreJ continuation of metadata 
k "d I I I wor at other parks was not cons1 ered a valuable use of NRB~B staff effort. 

While the relevance of metadata collection to NRBIB data collebtion is not immediately 
apparent, there are long-range applications for connection of t1'b two data types. Computer 
databases are becoming m~re compl_ex and interconnected, an~ it is con 1 eivable_ that one day 
metadata records could be mcluded·m the NRBIB. A researcher could then retneve both the 
bibliographic records and the records describing relevant spatii l data av~ilable for a park or 
subject; the spatial data then could be used to create illustrativ~ maps. This capability would be 
of great value in situations where parks cover large amounts o~territory land a multitude of 
habitats, or where park lands are intertwined with urban areas, such as s

1

anta Monica Mountains 
National Recreation Area near Los Angeles, California. J 

Conclusions And Future Directions · 

The future usefulness of the NRBIB databases is contin~ent on 9ontinual updates to retain 
the value of the information. For example, many parks had bibliographies available in paper 
format, but most of these were compiled in the 1970s and 1980f and we 1 e not current. These 
were produced by personnel at parks as well as personnel at universities and other research 
organizations. Some park personnel observed that someone frdm the region or from an outside 
organization periodically inventoried their materials, but the park often did not receive the 
product, and the inventory was soon outdated. When installing the NRBIB at the parks, NRBIB 
staff have attempted to instill in the park personnel some awareness of the usefulness of the 
databases to their work. Nevertheless, without regional support, the NRBIB databases will likely 
go unmaintained in the future . Information concerning national parks is becoming readily 
available to the general public, and in the face of increased public interest in and scrutiny of 
national park policies and actions, it is imperative that the parks be able to access documents 
needed for prudent and sound resource management. This will be feasible through ongoing 

. institutionalized support for the NRBIB database on both local and national levels. 

9 



Appendix A 
Park-Specific Data 

NORTHEAST REGION 

Philadelphia Support Office 
Contact person: John Kari sh (814) 865-7974 
Date of installation: 1/97 I 
Version of ProCite: Dos f 

Location of installed database: Office of the Chief Scientist, Univers · Park, PA 
Number ofrecords in database: 566 
Number of records for documents not found: none 

Comments: An NRBIB database was created for the docum ,nts cont ·ned within the Chief 
Scientist's office, using the NRBIB record number cod9s CHSO and ALSO. This office 
is also the location (installed 12/97) of the comprehensiye datab e containing all of the 
park databases for the Chesapeake and Allegheny clusters of the I ortheast Region 
(specific park information follows). I 

Chesapeake Cluster 

Appomatox Court House National Historical Park (APCO) 
Contact person: Ronald G. Wilson (804) 352-8987 
Date of installation: 8/21/97 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number of records in database: 82 
Number of records for documents not found: 4 

Assatea~ue Island National Seashore (ASIS) 
Contact person: Carl Zimmerman ( 410) 641-1443 
Date of installation: 2/24/97 
Version of ProCite: Windows 
Location of installed database: Library computer 
Number ofrecords in database: 639 
Number of records for documents not found: 20 

Comments: ASIS already had a ProCite database of their resource m agement holdings. 
This database was modified and enlarged to include all relevant RBIB materials. 
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Booker L Washin~ton National Monument (BOWA) 
Contact person: Tina Orcutt (540) 721-2094 
Date of installation: 8/19/97 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number of records in database: 49 
Number of records for documents not found: 1 

Colonial National Historical Park (COLO) 
Contact person: Chuck Rafkind (804) 898-8677 
Date of installation: 2/29/96 
Version of ProCite: Windows 
Location of installed database: Library computer 
Number of records in database: 607 
Number ofrecords for documents not found: 14 

Comments: COLO already had a ProCite database of their natural resource materials. This 
database was modified and enlarged to include all relevant NRBIB materials. 

Delaware Water Gap National Recreation Area (DEWA) 
Contact person: Beth Johnson (717) 588-2428 
Date of installation: 1/98 
Version of ProCite: Windows 
Location of installed database: Resource management office computer (Pierce House) 
Number of records in database: 2009 
Number of records for documents not found: 154 

Comments: DEW A and UPDE share many resources; documents that pertain to both are 
included in both park databases, with the locations at both parks included. 

Eisenhower National Historic Site (EISE) 
see Gettysburg National Military Park (GETT) 

Fredericksbur~ and Spotsylvania National Military Park (FRSP) 
Contact person: Susan Alberts (540) 373-0834 
Date of installation: 4/3/96 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number of records in database: 200 
Number of records for documents not found: none 
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Historic Site (THST) 
Contact person: Karen Heppler (804) 224-1732 
Date of installation: 10/18/96 
Version of ProCite: Windows 
Location of installed database: Library computer 
Number of records in database: 127 
Number ofrecords for documents not found: 1 

Comments: One database contains records for both parks. 1 ere 1are [ 12 records specific to 
GEW A and 16 records specific to THST, with some ov~rlap lbe I een them. 

Contact person: Burt Frost (717) 334-3777 
Date of installation: 1/31/97 
Version of ProCite: Windows 

I I 

Location of installed database: Resource management office comput r 
Number ofrecords in database: 927 
Number of records for documents not found: 26 

Comments: One database contains records for both parks. All 927 reco ds pertain to GETT, and 
413 of these also pertain to EISE. 

Hopewell Furnace National Historic Site (HOFU) 
Contact person: Roger Stone (610) 582-8773 
Date of installation: 8/21 /96 
Version of ProCite: Windows 
Location of installed database: Park Headquarters library computer . 
Number ofrecords in database: 215 
Number of records for documents not found: 2 

Petersbur~ National Battlefield (PETE) 
Contact person: Dave Shockley (804) 732-0171 
Date of installation: 4/3/96 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number ofrecords in database: 91 
Number of records for documents not found: none 
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Richmond National Battlefield Parle (RICH) 
Contact person: Mike Brennan (804) 795-6019 
Date of installation: 3/28/96 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number of records in database: 139 
Number of records for documents not found: 3 

Shenandoah National Park CSHEN) 
Contact person: Tom Blount (540) 999-3497 
Date of installation: 12/97 
Version of ProCite: Windows 
Location of installed database: Inventory and Monitoring Building library computer 
Number of records in database: 2803 
Number ofrecords for documents not found: 191 

Comments: The SHEN database is the most thorough and detailed database of the ones done 
by PSU. Park staff are exploring the possibility of connecting the database with the park 
GIS data on an FTP site on the Internet. 

Thomas Stone National Historic Site (THST) 
see George Washington Birthplace National Memorial (GEWA) 

Upper Delaware Scenic and Recreational River (UPDE) 
Contact person: Don Hamilton (717) 729-7842 
Date of installation: 10/9/97 
Version of ProCite: Windows 
Location of installed database: Records mangement office computer 
Number of records in database: 1543 
Number ofrecords for documents not found: 35 

Comments: UPDE controls (owns) a minimal amount of park lands and many of the records 
are from outside sources. DEW A and UPDE share many resources; documents that 
pertain to both are included in both park databases, with the locations at both parks 
included. UPDE may put their copy of ProCite on a park network so more staff members 
can use the database. 
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Valley For~e National Historical Park (V AFO) 
Contact person: Brian Lambert (610) 296-2583 
Date of installation: 10/9/97 
Version of ProCite: Windows 
Location of installed database: Huntington's Quarters, Nature Cente 
Number ofrecords in database: 271 
Number ofrecords for documents not found: 14 

Allegheny Cluster 

Memorial (JOFL) 
Contact person: Brian Eick (814) 886-6128 
Date of installation: 2/13/96 
Version of ProCite: Windows 
Location of installed database: Resource management offic9 comput r 
Number of records in database: 45 1 

Number of records for documents not found: 7 

Comments: One database contains records for both parks. Thirty-thr , e of the 45 records 
pertain to JOFL as well as ALPO. The rest are only from ALPO This is a very small 
database and may be put on a network between the offices of JO : Land ALPO. 

Bluestone Nationi;t! Scenic River (BLUE) 
see New River Gorge National River (NERI) 

Fort Necessity National Battlefield (FONE) 
Contact person: Connie Ranson (412) 329-5809 
Date of installation: 9/21 /96 
Version of ProCite: Dos 
Location of installed database: Resource management office and park library 
Number of records in database: 192 
Number of records for documents not found: 2 

Comments: This park shares some records with FRHI. Locations of ocuments in both parks 
are included. 
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Friendship Hill National Historic Site (FRHI) 
Contact person: Kitty Seifert ( 412) 725-9190 
Date of installation: 2/5/97 
Version of ProCite: Dos 
Location of installed database: Park Headquarter library computer 
Number of records in database: 264 
Number of records for documents not found: 4 

Comments: This park shares some records with FONE. Locations of documents in both parks 
are included. 

Gauley River National Recreation Area (GARI) 
see New River Gorge National River (NERI) 

Johnstown Flood National Memorial (JOEL) 
see Allegheny Portage Railroad National Historic Site (ALPO) 

New River Gor2e National River (NERI), Bluestone National Scenic River (BLUE), and Gauley 
River National Recreation Area (GARI) 

Contact person: Katy Miller (304) 465-0508 
Date of installation: 2/12/96 
Version of ProCite: Windows 
Location of installed database: Resource Management computer 
Number of records in database: 402 
Number of records for documents not found: 25 

Comments: One database contains records for all three parks. There are 353 records specific 
to NERI, 33 records specific to BLUE, and 52 records specific to GARI, with some 
overlap between them. 

NATIONAL CAPITAL REGION 

Center for Urban Ecolo2y (CUE) 
Contact person: Jim Sherald (202) 342-1443 ext. 208 
Date of installation: 11 /97 
Version of ProCite: Windows 
Location of installed database: Jim Sherald' s office 

Comments: This office is the location of the comprehensive database containing all of the park 
databases for the National Capital Region (specific park information follows). 
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Antietam National Battlefield (ANTI) 
Contact person: Ed Wenschhof (301) 432-2243 
Date of installation: 8/3/96 
Version of ProCite: Dos 
Location of installed database: Natural resource management comput .r 
Number ofrecords in database: 166 1 

Number of records for documents not found: none 

Catoctin Mountain Park (CATO) 
Contact person: Jim Voigt (301) 416-0536 
Date of installation: 8/3/96 
Version of ProCite: Dos 
Location of installed database: Resource management computer 
Number ofrecords in database: 38 I 
Number of records for documents not found: none 

Chesapeake and Ohio Canal National Historical Park (CHOH) 
Contact person: Pat Toops (30 I) 739-4200 
Date of installation: 12/12/96 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number of records in database: 999 
Number of records for documents not found: 75 

Comments: The park was in the process ofrelocating documents at th time of the database 
installation. Location information is being revised by park staff. 

Geon~e Washin~on Memorial Parkway (GWMP) 
Contact person: Dan Sealy (703) 285-2704 
Date of installation: 3/6/97 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number of records in database: 319 
Number of records for documents not found: 21 

Comments: GWMP already had a ProCite database containing selecte natural resource 
documents. This database was modified and enlarged to include 11 relevant NRBIB 
materials. 
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Greenbelt Park (GREE) 
Contact person: Shelly Gigliotti (301) 344-3944 
Date of installation: 10/17 /96 
Version of ProCite: Windows 
Location of installed database: Ranger Station computer 
Number of records in database: 109 
Number of records for documents not found: none 

Comments: The administration of Greenbelt Park is overseen by the National Capital Parks­
East office. The Greenbelt database records were therefore all included in the NACE 
database, but Greenbelt received its own database of only GREE records. 

Harper's Ferry National Historic Site (HAFE) 
Contact person: Bill Hebb (304) 535-6038 
Date of installation: 4/2/96 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number ofrecords in database: 144 
Number of records for documents not found: 6 

Manassas National Battlefield Park (MANA) 
Contact person: · Bryan Gorsira (703) 754-8694 
Date of installation: l l / 13/96 
Version of ProCite: Windows 
Location of installed database: Resource management computer 
Number ofrecords in database: 167 
Number of records for documents not found: 10 

National Capital Parks-East (NACE) 
Contact person: Steve Syfax (202) 690-5185 
Date of installation: 1 /31 /97 
Version of ProCite: Windows 
Location of installed database: Computer of park librarian 
Number of records in database: 394 
Number of records for documents not found: none 

Comments: This office oversees administration of many small park units in eastern 
Washington D.C. and Maryland and Virginia, including Piscataway Park (PISC), 
Kenilworth, and Greenbelt Park (GREE). Of these parks, Greenbelt received its own 
database of just the GREE records (see Greenbelt Park). 
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Prince William Forest Parle (PRWI) 
Contact person: Ann (Sartori) Brazinski (703) 221-2176 
Date of installation: 11/12/96 
Version of ProCite: Windows 
Location of installed database: Resource Management computer 
Number of records in database: 261 
Number of records for documents not found: none 

Comments: PR WI already had a Pro Cite database containing resourc . management 
documents. This database was modified and enlarged to include 11 relevant NRBIB 
materials. 

Rock Creek Park (ROCR) 
Contact person: Bob Ford (202) 282-7621 
Date of installation: 6/ 1 7 /97 
Version of ProCite: Windows 
Location of installed database: Natural Resource Mangement comput r 
Number ofrecords in database: 385 
Number of records for documents not found: none 

Comments: Rock Creek Park administers many smaller park units in ashington D.C. and 
Maryland, including Glover-Archbold Park and Battery Kemble : ark. Records for all 
these parks are included in this database. 
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Section 1: Adding records to your Pro-Cite datahas (DOS version) 

Creating a new record using templates 
(templates are dwnmy records which contain brief instructions for ente ng data in each field) 

1. Open the database. 

2. At the Main Menu, hit "E" (Edit, Insert, View). A record will be displ yed. 

3. Hit "j" to "jump" 

4. When it asks you to enter a record number, type 1 (or the number oft e template you want, if 
you know it.) I 

*note: if it asks for an alphabetic letter rather than a number, you will need tolchange yo r database settings - check 
your manual for instructions, or call for help. 

5. If you hit "1 ", you will be at the first template. In the bottom left-han comer it will say which 
template it is (e.g. Books-Long, Report, etc.). Hit "n" to move through e templates until you 
find the one you need: 

record# 1: Reports (workform E) 
record# 2: Books, or book chapters (workform A) 
record# 3: Journal articles (workform D) 
record# 4: Dissertationsffheses or school papers (workform G) 
record# 5: Memos or Letters (workform I) 
record# 6: Conference Proceedings or papers presented at meetings (w , rkform K) 
record# 7: Maps (workform L) 
record # 8: Audio recordings ( workf orm N) 
record# 9: Videos (workform Q) 
record# 10: Computer files (workform T) 
record# 11: Photographs or Slides (workform P) 
record# 12: Unpublished items (manuscripts, etc.) (workform J) 

6. IMPORTANT: Hit "U". This will make an exact duplicate of the rec ,rd (if you forget and 
type onto the template itself without making a duplicate, you can copy t1 templates from the 
"Template" database - see the instructions below). 

7. Fill in the record by following the directions in this handout (listed al habetically by the name 
of the field). 
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Creating a new record from scratch: 

1. Open the database. 

2. At the Main Menu, hit "E" (Edit, Insert, View). A record will be displayed. 

3. Hit "W" (change Workform) and select the workform you will need: 

Journal articles: Use form D 
Books or chapters in books: Use form A 
Reports: Use form E 
Dissertationffhesis/School paper: Use form G 
Conference Proceedings: Use form K 
Memos or Letters: Use form I 
Maps: Use form L 
Photographs or Slides: Use form P 
Videos: Use form Q 
Audio recordings: Use form N 
Computer file : Use form T 
Unpublished document: Use form J (Manuscript) 

4. Hit "I" (Insert) to bring up a blank workform. 

5. Enter information according to the conventions listed below. 

Repairing templates: 

1. First, go to the record that you created by typing over the template (it will have a record 
number 1-12, because those are the numbers of the templates). 

2. Hit "U" to make a duplicate copy of that record. (Check the record number to see that it is now 
greater than 12). 

3. Now go back to your previous record and hit "D" to delete it. (You can get back by using the 
"J" command and entering the record number.) 

4. Go to the Main Menu (by hitting ESC until you're there), then hit "D". 

5. Hit "O" for "open database" and use the arrow keys to select the "template" database. 

6. Hit "S" for "search database" then "N" for "select none." 

7. Hit ESC to get back to the Main Menu. 
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8. Hit "E" to get into the records. 

9. Now use the "N" (next) and "P" (previous) keys to find the
1
templat /templates you want to 

copy. 

10. When you find one, hit "S" to "select" that record. 

I 
11 . When all the templates you want have been selected, hit "X" to go back to the Main Menu. 

12. Hit "U" for "utilities", then "C" for "copy selected record~ and wo 

13. Hit "O" for "open database" and select your park database by usin The 
records will be copied into your database. 

14. The last step is to open your database again by selecting "D" from e Main Menu, selecting 
"O" to list the database and using the arrow keys to get to the lone you ant. 

I 
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Section 2: Adding records to your Pro-Cite database (Windows version) 

[Note: this handout assumes a basic knowledge of Windows operating procedures] 

Opening the database 
1. Double click on the Pro-Cite icon. 

2. If a database comes up that you don't want, choose "Close" from the File menu. 

3. To open the database you want, choose "Open" from the File menu. Double click on the 
database folder if necessary, then double click on the name of the database you want to open. 

Creating a new record using templates 
(templates are dummy records which contain brief instructions for entering data in each field) 

4. If the first twelve records in the list are not templates (sample records with instructions for 
entering data in each field), sort the database by record number. From the View menu, select 
"Sort by" and choose "record number" and "ascending." Make a note of the current settings in 
case you need to return the database to its original order. 

5. Cursor down through the list until you reach the workform that describes the item you wish to 
add to the database. Press return or double click to open the template. 

6. Make a duplicate of the template. In order to do this, from the Database menu select "New 
record", and then from the Edit menu choose "Insert previous record." 

7. Fill in the fields as explained in the template, and then delete the instructions. To move from 
field to field, use the tab key (shift-tab to move up) or point and click. (If you accidentally 
overwrite the template, you can copy a new one from the template database. See the section 
below for instructions.) 

8. When finished entering data for the record, press F 10 to save and "Close" twice from the Edit 
menu to close the record and template windows. Return to step five to add more records. 

Creating a new record from scratch 

4. Press F9 to create a new record. 

5. Click on the workform menu (upper left comer of the record) and select the appropriate 
workform. 

6. Enter data according to the conventions listed below. 
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7. When finished entering data for the record, press FlO. Return to step our to add more records. 

Repairing templates: 

1. First, open the record that you created by typing over the template. (I will have a record 
number 1-12, because those are the numbers of the templates). 

2. From the Database menu, choose "new record." (Check the record n 
greater than 12.) Frqm the Edit menu choose "Insert previous record," 
save the new record. 

her to see that it is now 
d then press F 10 to 

3. From the File menu, choose "close," and then type Control-D to dele e the accidental record. 

4. Now you have to replace the template. Do this by opening the datab se named "template.dat." 

5. Cursor through the list until you find the work form which was ove itten. If no records are 
marked (see status line at bottom of screen) type Control-M to mark the record. If other records 
are marked (they will have an "x" in the box to the left of them in the li t), type Control-shift-K 
to clear the marked set, and then Control-M to mark the highlighted rec , rd. 

6. From the Database menu, choose "Copy marked records." 

7. Double-click on the name of the database in which the template was verwritten. 

8. From the File menu, choose "Close." 
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Section 3: Conventions for entering information 

General philosophy 

Every record should satisfy these 3 tests ... 

]) Will a user who wants this record be able to find it? 

Since users find records by entering words which are matched with words in the database, it is 
very important to avoid abbreviations and misspellings (a search on "integrated pest 
management" will not find a misspelling such as "intgrated pest management" or an abbreviation 
such as "integrated pest mgt. ", or an acronym such as "IPM"). The only abbreviations used in 
this database are "US" and the two-letter codes for state names. Since acronyms can be 
ambiguous or meaningless, they should be avoided. It's fine to use both the acronym and the full 
spelling in parentheses. 

2) Once a user finds this record, will slhe be able to decide whether the document it describes 
will be useful? 

The abstract is the most important part of the record for this purpose. It should give the user 
enough information to know whether the document will contain useful information. 

3) Once a user decides the document will be useful, wills/he be able to find it? 

This depends on how complete the location information is, (and whether the documents are 
moved around in the park, but that ' s another story) so be as specific as possible here. 

Workform guidelines 
Use this workform... for ... 

audiovisual material .... ... ........ photographs and slides 
book - long form ... .......... ....... published books 
conference proceedings .. .... .... collection of papers from a meeting (includes fields for date and 

location of meeting) 
dissertation ..... ...... ......... ....... .. PhD dissertation, MS thesis or school paper 
journal, long ................. .. ... .... . article in a journal or magazine 
letter (correspondence) ... ... ..... memos, letters (includes field for 'recipient', none for ' title') 
manuscript.. ......... .... ..... .. .... .... unpublished works include unpublished reports 
map .... .... .... .. .............. ....... ...... maps (includes fields for scale, size) 
report .......... ..... ... .......... ....... .. . often have a "report number", otherwise similar to a book -- if the 

report is unpublished, use the "manuscript" form 
video recording .... ..... ... .... ...... videos (includes field for type of video -- e.g., VHS) 
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Entry guidelines (alphabetically by field name) 

Abstract (Abst): 
Provides information about the subject matter contained in the docurne t. Imagine what would 
help the user decide whether it's worthwhile to search out this idocume t. Sometimes the table of 
contents is a good summary and can be typed in as an abstract. This is lso the place to make 
references to related documents. (e.g. a rough draft or an unpublished ersion) 

Article Title: 
The title of an article in a journal or magazine. Type it exactlyj as it ap ears. If it is misspelled, 
make a comment about this in the note field so that someone using the atabase will not mistake 
it for a typo. 

Author, Analytic & Author, Monographic (Auth): 
* Note: some workforms have more than one author field. If so, the irst author field 
("analytical") is for the author of a section of the work (e.g. a chapter i a book or a single paper 
in a conference proceedings), and the second field ("monograJl)hic") is or the author of the work 
as a whole. If you are describing the work as a whole, use only the sec nd author field and leave 
the first blank. 

Each author is separated from others by a double slash "//". (This allo · 
between multiple authors.) If you know the full name, spell it out, othe 
author is identified, enter "=author unknown". 

Last name, first, middle =any title such as editor, or Jr. 
Mills, James H =Sr. 
=author unknown 

s ProCite to distinguish 
ise use initials. If no 

Entering names in this way allows Pro-Cite to distinguish last names fi om first and middle 
names. An equal sign before titles such as "Jr." tells Pro-Cite this is n It part of the name. 

Organizations that are considered authors are entered as follows. (Agai , an equal sign tells Pro­
Cite that what follows is not a individual's name.) 

=name of organization 
=American Geological Society 

Author Affiliation: 
Name of the institution with which the author is affiliated. Type it as i appears on the document. 

Author Role: 
Use only if there is one author (or all authors have the same role). Use ; for things like "editor", 
"compiler", "project manager". 

Author, Subsidiary: 
Rarely used. This refers to someone who has revised an existing work. (e.g., a translator) 

26 



11/25/97 

Availability: 
Rarely used. This is where you can enter information about where the document can be 
purchased. (e.g., through the Government Printing Office) 

CODEN: 
Rarely used. A CODEN is an international code assigned to a journal/magazine. Similar to ISSN. 

Call Number (Call): 
Describes the location of the document. Enter the region code followed by a hyphen, followed by 
the four-letter park code, followed by a space, a slash and another space " / ". Then describe the 
items location, spelling out the park name, then name of the collection ( e.g. library or vertical 
file) and the name of the file or the call number. Be sure that this is descriptive enough that an 
individual will be able to go directly to the document without looking through several others. 

REGION CODE-PARK CODE I Description of location 
NEFA-NERI I New River Gorge National River, Vertical file, "water quality"fi/e 

If the document is held by an agency outside the park service, enter a description of the 
document location and any other useful information to help someone locate the item. ( e.g. a 
phone number or address) 

If a citation is found, but the location of the document is unknown, type "citation only, document 
not found". Include title, author(s), and date. Give the source of the citation in the note field. 

Cartographer (Cart): 
Enter the name of the map maker the way you would an author. (i.e., Last name, first, middle) 

Collection title: 
Rarely used. Refers to the name of a collection of documents. ( e.g., in an archive) 

Connective Phrase: 
Only used when record refers to a portion of a larger work. Enter a word or phrase which 
describes how a section of a work refers to the work as a whole. (e.g. "In" .. . , "Within" ... , 
"Chapter 3 of' .. . ) 

Date of Copyright: 
Rarely used in this database. Generally a work is copyrighted in the same year that it is produced. 
Occasionally (particularly with latter editions of a work), the copyright date is different. A 
copyright date can be identified by the symbol in front of the date (a letter 'c' in a circle). 
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Date of Publication: 
The year is the most important element. Type in all four digits. If the e is a span, write out all 
four digits of each year with a hyphen between (e.g. 1987-1988, not 1 87-88). You may add the 
month and day if they are available (spell out the month). If you don't know the date, guess 
(based upon clues like the dates of references) and type it like this: 19 ? or 1992?. If you can't 
guess what decade it belongs to, type "no date". If there are several ite, s (e.g., several 
newspaper clippings in a folder or several photographs in a collection) you may need to resort to 
"various dates" . 

Month day, 19## 
January 26, 1994 

Date of Meeting (DtMt): 
For conference proceedings the date in which the conference took plac is entered here. Use the 
same form as for the publication date (i.e., month, day, year) 

Descriptors: 
see Keywords 

Director (Dctr): 
If a director is listed for a video cassette, enter her/his name here in th same form you enter 
author names. (i.e., Last name, first, middle) 

Distributor (Dist): 
If a distributor is listed for a video, enter the name here as it appears o , the video. 

Document Type: 
Not used in this database. 

Edition: 
Rarely used in this database. Indicates if this is a second or third (etc.). edition of a work. (Draft 
and final reports are not considered 'editions' for this purpose.) 

Editor/Compiler: 
Enter the name of an editor/compiler the way you would an author. (i . . , Last name, first, middle) 

Editor/Compiler Role 
Enter 'compiler' or 'editor' or whatever term describes what the perso listed in the 
editor/compiler field did. I 

Extent of Work (Extn): 
This reflects the size of the item. Use the appropriate descriptive term (e.g. cassettes, maps, 
photos). For a printed document, list the number of pages. If the page are not numbered, guess 
and enter your guess like this: 40+ p. 

# p ., # slides, etc. 
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ISBN: 
Rarely used. This stands for "International Standard Book Number," a 10-digit number assigned 
to each published book. 

ISSN: 
Rarely used. This stands for 'International Standard Serial Number' which is a number assigned 
to eachjournal/magazine published. See also 'CODEN' . 

Issue Identification: 
Enter the number by itself (don' t include the word issue). Journals are generally published in 
volumes. A volume is usually all the issues for one year (January-December). Each issue may 
also have an issue number (e.g., issue 5 would be the fifth issue in the current volume). There 
may be no issue number, or the issue number may be the date. 

Journal Title (Jrnl): 
Enter the entire title. (Don't abbreviate if you know the full spelling, but don't guess at the full 
spelling -- it's very easy to be wrong.) If the exact name of the journal isn't clear, (e.g. bulletin of 
the American Society ofX vs. The American Society ofX bulletin), use your judgment. 

Keywords: 
There are actually 5 types of information that fit in this field: _ 
1.) General area of study (e.g., GEOLOGY, ANIMAL STUDIES, MANAGEMEMT) 
2.) Subject terms (taken from the existing subject list, if possible) 
3.) Document type terms (such as Environmental Impact Statement (EIS), annual report, or 
checklist) 
4.) Form terms (such as map, video or photographs) 
5.) Geographic area (park name, state name, geographic feature such as a lake or mountain) 

NRBIB: CODE-#### I GENERAL AREA OF STUDY/subjects/form/document 
type/Geographic location 
NRBIB: NERI-1000 /AQUATIC SCIENCES /water resource management /water quality 
/pollution I.fish /invertebrates /checklist /video /New River Gorge National River, WV 

The keyword field is one of the most important portions of the record. Many searchers will 
want information on a given topic and this will be the best way for them to find everything they 
want. Whenever you select a term to assign, ask yourself the following questions: 

1) If I was searching for documents on this topic, would I be happy that this one was found? 
2) If I was searching for documents on this topic, would I be upset that this one was not found? 

Use the most specific term(s) that accurately describe the document. For example, if the 
document is about pocket gophers, use "pocket gophers" rather than "rodents" or "mammals" or 
"animals" . Always check the list for existing terms before assigning new terms. 
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If you do add a new term ask yourself "will anyone be searching for ite s on this topic?", and 
"is this the right word to use - is there another term that is more commo y used and/or less 
ambiguous?". 

If the subject is a name, follow the name of a feature (lake, mountain, et .) by the park code in 
parentheses, or, if you don't know that it's in the park, by the state. 
follow the name of a place by the state it's in. 

Sandstone Falls (NERI) 
San Juan County, NM 

If the subject is a species, start with the common name and add the genu and species in 
parentheses. 

common name (genus species) 
mountain goat (Oreamnos americanus) 

If you only have the common name, use that and fill in the rest later. If y u only have the 
scientific name, add the type of animal or plant in parentheses. 

Scientific name (type) 
Abies magnifica (tree) 

Letter to (Ltto): 
Enter the name of the individual the letter or memo is addressed to (inn rmal order, not inverted 
like an author name). 

First name, middle, last 
Smoky D. Bear 

Location in work (Loe): 
This field is used when you are describing a portion of a document rathe than the entire 
document. For a journal citation, the span of numbers stands alone (with ut the designation "p."). 

p. ##-## (for books or reports) ##-## (for journal articles) 
p. 23-27 (for books or reports) 23-27 (for journal articles) 

Map Type: 
Not used in this database. 

Medium Designator: 
Not used in this database. 

Notes (Note): 
This is the place for comments about the document itself (the physical c ndition of the copy, the 
relationship to other document ( e.g. a draft version), whether the info~ tion is sensitive, 
whether this is the only existing copy, comments about missing information, notes about 
misspelled titles. Also, when you are entering a citation and have not fo I d the actual document, 
this is the place to enter the title of the document in which you found th citation. 
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Packaging Method (PaMe): 
Used to describe type of videocassette -- enter "VHS", "Beta", or "Pal" 

Paper/Section Title (Papr): 
For conference proceedings, the title of the paper within the proceedings is entered here. (Follow 
the rules for titles). 

Place of Meeting (PIMt): 
For conference proceedings the meeting location is entered here (as it appears on the conference 
proceedings). 

Place of Publication (PIPb ): 
The city and state, or country. Use the two-letter abbreviations for state names. This is one of 
the few abbreviations used in the database. 

Proceedings Title: 
Title of conference proceedings. Enter as you would other titles. Enter title of individual paper 
or section in the 'paper/section title' field. 

Producer (Prod): 
If a producer is listed for a video, enter the name here in the same form as in the author field. 
(i.e., Last name, first, middle, or =Organization name) 

Producer Role: 
Enter the word describing the producer's role (e.g., "producer,") if there is one. 

Publisher (Puhl): 
This is the place for names of organizations involved in producing the document. Sometimes the 
publisher is the author. If this is the case, go ahead and repeat the name here. If there is more 
than one organization involved, type the name of the first, then the word "and", then the name of 
the second. 

Report Identifier (RplD): 
Enter report numbers here (there may be more than one). Include any words that accompany the 
number. (e.g., NPS Report# ... ) 

Reproduction Ratio: 
Not used in this database. 

Scale (Seal): 
Type the scale of the map as it is shown on the map (if available). 
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Section: 
In the Report Form, this is where you type the title of a section of the re ort if you are describing 
only a section rather than the report as a whole. (Rather uncommon.) E ter it the way you would 
any other title. 

Series Editor 
If the work belongs to a series ( a group of publications with a group n 
series is given, enter the name here as you would an author name. (i.e., 

Series Editor Role: 

e ), and the editor of the 
ast name, first, middle.) 

If there is a series editor, enter the name of that person or organization's role. (e.g., "series 
editor") in this field. 

Series Issue ID: 
If the document is part of a series ( a group of publications with a group ame ), and an issue 
number is given for this work in the series, enter it here as it appears on he document. ( e.g., 
"issue 5") 

Series Title (SrTi): 
A "series title" is a overall title for a collection of documents published • s a series. (Enter as you 
would any other title.) 

Series Volume ID: 
If the document is part of a series (a group of publications with a group ame), and a volume 
number is given for this work in the series, enter it here as it appears on the document. (e.g., 
"volume 5") 

Size: 
This refers to physical size (e.g. number of cassettes, width and length o a map). 

Storage Location: 
Not used in this database. Use the 'Call Number' field to record the loc tion of the item. 

Title, analytic & Title, monographic (Titl): 
*note: in some workforms, there is more than one title field. The first is or the title of a section 
(chapter, etc.). Use this if you are only describing this portion of the wo ,k. The second title field 
is for the title of the entire work. 

Enter the title the way it appears on the document. If it is misspelled, m e a note of this in the 
note field. 
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Sometimes it isn't clear what the exact title is, or the document may not have a title. Do your 
best. If there is no title, create one (e.g., "Untitled: Handwritten Wildlife- Observation Notes"). 
If there are several titles, choose the one that seems most official (the one on the title page, if 
there is one). If the document is a draft, preliminary copy, etc. you may add this information in 
brackets (e.g. [Draft]). 

University (Univ): 
The affiliation of the author of a document 

Name of university, name of department 
State University, Department of Geosciences 

Volume Identification: 
Simply type the number of the volume. Journals are generally published in volumes. A volume 
is usually all the issues for one year (January-December). Each issue may also have an issue 
number (e.g. issue 5 would be the fifth issue in the current volume). There may be no issue 
number, or the issue number may be the date. 
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Section 4: Vocabulary terms and sources for furt er information 

analytic (versus monographic ): An analytic author or title is the autho or title of a section of a 
larger work (a chapter in a book or a section of a report). Usual y you will be interested in 
the work as a whole, but occasionally you may be interested in nly one section, then this 
comes in handy. 

authority list: A list of words/phrases in the form the should be used c:ol nsistently. You may have 
an authority list for keywords. This will tell you how a concept is expressed in the 
database (e.g. "threatened & endangered species", not "T&E s ecies" or "E&T species"). 

call number: This is the number found on the spine of a book in the li rary. It determines where 
the book is located in a library. For park databases, this field is sed for the location of 
the item. 

field: Each record describes one item. Each record consists of several 1elds. Each field contains 
one type of information (for example the authors or the abstrac ). 

keyword: Terms added to a record to make searching easier. (General~y they are subject terms 
like "fire management" or "black bears (Ursus americanus)" but they could also be terms 
like "aerial photographs" or "slides". 

monographic (as opposed to analytic): monographic authors or titles i e authors/or titles of an 
entire work (as opposed to sections of the work) . This is what )l'Ou'll encounter most 
often. 

series title: If a book or report belongs to a group of similar document it may have a title for 
that group/series (something like "Water Resource Reports, nu ber 5"). 

workform: A workform is a record type. There are workforms for bo9ks, workforms for articles, 
workforms for dissertations, etc ... (these are listed and explained in the first section of this 
handout). Each workform contains the fields that are t Jpropriale to that type of item. For 
example, the map workform contains a field for "scale" and th6 article workforms contain 
a field for "journal title". 

Sources of more information: 
Procite for Windows manuals (Reference Manual and User's Guide) 
Online Help ( click on the Help button in Procite) 
Procite in the NPS manual (available through the Park Service Librl Program) 

Thanks to Marilyn Ostergren for the use of her materials in the pre , aralion of these. 
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A NATURAL RESOURCE BIBLIOGRAPIDC DATABA E FOR THE 
PARKS IN THE CHESAPEAKE/ALLEGHENY CLUSTERS A THE NATIONAL 

CAPITAL FIELD AREA OF THE NATIONAL PARK SERVICE 

As part of the National Park Service's (NPS) Inventory and Monito · Program, a project has 
been initiated to develop a Natural Resource Bibliographic Database or national parks. This 
database will describe all reports and other documents, including ph910s, maps, and museum 
specimens, which contain information about the natural resources of thf park and its immediate 
area. This project began in the Pacific Northwest Region in 1992, and in the Alaska, Rocky 
Mountain, and Southwest regions in 1994. Beginning in August 1995, t e project will be initiated 
in the parks in the Chesapeake/ Allegheny clusters and the National Capi al Field Area. Ev~ntually 
there will be a servicewide resource bibliography accessible on CD-RO 

Description and Goals 

The goal of this project is to develop a Natural Resource Bibliographic Database. 
Thedatabase will include the bibliographic citation, an abstract of th material, keywords, its 
storage location, and other important information. It will include all materials related to the 
natural resources of each specific NPS unit. Natural resources in this ase include flora, fauna, 
soil, air, water, rocks, and activities that affect them, such as mining, gxrazing, polluting, logging, 
and recreating. The project is expected to take 2 years to complete. I 

The NPS has adopted the bibliographic software called PRO-CITE as the servicewide standard 
for this project. PRO-CITE is menu-driven and very flexible in seard methods~ items can be 
found by subject, author, date, location, etc. Items can be viewed on screen, printed in 
bibliographic formats, or incorporated into word processing documents. 

Procedures 

In order to compile the database, cooperative agreements hav
1
e been signed with The 

Pennsylvania State University and North Caro .. .ia State University. Personnel at these universities 
will be dividing the parks, primarily geographically. We will visit each NPS unit in our "half' of 
the field area and systematically examine collections of natural esource materials ( e.g., 
documents, slides, maps, etc.) and enter relevant citations into the da abase. Some parks may 
already have some form of automated bibliography for their libraries~ when possible we will 
convert these into PRO-CITE. Depending on the size of the park, we eki,ect it to take between 1 
week to several months to complete a given park. We will have our owp computers and enter the 
information directly into them. I 

When this process is completed, we will edit the database for accuracy and uniformity. We 
will also be searching other sources (e.g., regional office, university libraries) and adding 
additional citations. When we have a finished database for a park, we ~ deliver it, install PRO­
CITE at the park, and train interested personnel in its use. When dapibases for all parks have 
been completed, a combined database will be available. It should be noted, however, that only a 
limited specific amount of funds have been provided from W ASO to acbomplish the total project, 
so the time spent at any given park may not be adequate to complete the database. In these cases, 
it is hoped that park staff will be able to complete the task as time pe '1ts. 
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Long-Term Maintenance 

Each park will be provided with its own copy of PRO-CITE software, instructions for use, and 
the bibliographic database. The databases are to be maintained at each unit, with the staff 
entering new records when they become ·available. The system support office will have a master 
copy of the combined database, which will periodically be updated from the individual park's 
copies. 

Role of the Parks 

We will contact each unit again before we make our visit to begin the project. Each park 
should designate a staff member to be our contact person for the purpose of organizing the visit. 
During our visit, any assistance that may be available with locating records, either in the park or in 
other locations (e.g., adjacent public lands), entering data, and transferring data from existing park 
databases would be greatly appreciated. We ask the park to provide us with a workplace, and if 
necessary for converting existing files, access to a park computer. We may also ask for housing 
at the parks if available. 

Upon completion of the database we will need to train at least one staff member on its use. For 
some of the smaller units, we may organize combined training sessions, but this is still just a 
consideration. 

Contacts 

If there are any questions regarding any aspect of the project feel free to contact either Kathy 
Derge or Scott Tiffuey at the Pennsylvania State University. 

Kathy Derge 
Rm 204 Ferguson Building 
The Pennsylvania State University 
University Park, PA 
16802 
(814) 863-1904 
kld8@psu.edu 

Scott Tiflhey 
Rm 204D Ferguson Building 
The Pennsylvania State University 
University Park, PA 
16802 
(814) 863-1904 
sdt3@psu.edu or via ccmail 
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Starting Pro-Cite (DOS Version) 

STEP 1 : Opening Pro-Cite 

!) Begin at the DOS prompt: C:I> (pressing: ESC will often get r:ere). 

2) Type: cd\procite and press: ENTER to get to the C:\PROCJ. j .l!.,-"' prompt. 

3) At the C:\PROCITE> prompt, type: procite and press: ENTER 

4) At the Pro-Cite screen, either hit the spacebar or wait for the 
appear. 

5) You are now ready to begin using your Pro-Cite database. Follo the steps in the handouts 
provided for the particular procedure you wish to perf onn or con ult the Pro-Cite manual. 
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Exiting Pro-Cite {DOS Version) 

STEP 1 : Quitting your Application 

1) Press: ESC until you are back at the Main Menu. 

2) At the Main Menu, if your database is still open (you will know this if all items in the Main 
Menu are accessible and can be highlighted) type: d for Databases. 

STEP 1 : Closing your Database 

1) At the Databases Menu, type: c for Oose Current Database. 

2) Press: ESC to return to the Main Menu (items 2 through 8 should now no longer be 
accessible). 

STEP J : Leaving Pro-Cite 

1) Type: q for Quit. 

2) Back in DOS at the C:\PROCITE> prompt, type: ed .. to return to the 
C:\> prompt. 
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Searching Pro-Cite (DOS Version) 

STEP 1 : Opening your Database 

I) At the Main Menu, type: d for Databases. 

2) At the Databases Menu, type: o for Open Database. 

3) The name of your database should appear. 

4) Use the arrow keys to select it and press: ENTER. 

STl!P 1. : Begin Your Search 

I) Back at the Main Menu, type: s for Search Databases. 

2) Type: a for Select All (there will be no menu change when yo do this) . 

3) Type: s for Search Selected Records . You should now be at the Search Expression 
screen. I 

STIEi? 3 : A Basic Search 

I) At the Search Expression screen, press: F2. The Pro-Cite Fields window will appear. 

2) Use the arrow keys to select the Pro-Cite field you wish to searJ (Consult the Pro-Cite 
Workform FLld Abbreviations handout for a description of eafh field, its field number 
and abbreviation), then press: ENTER. Your search field numbe or abbreviation will 
appear in the Search Expression window. 

3) Type in your search term(s)" for your selected search field immediately following the = 
sign. 

* If you are using more than one search term for your selected search field, you must 
combine each word with "and" (e.g. gypsy and moth) or enciol e them in quotation marks 
(e.g. "gypsy moth"). I 
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4) Wait a moment and Pro-Cite will display your search result at the bottom right-hand corner 
of the Search Expression screen. Press: ESC three times until you return to the Main 
Menu. 

STEP 4 : Viewing your Search Results 

1) At the Main Menu, type: b to Browse the database. You will see the first 4 fields of three 
records in your database. The records which match your search will be highlighted. 

2) To see the records which match your search, type: t for the next selected record [nexTsel] 
or type: v for the previous selected record [preVsel]. The record in the middle window is 
always the "active record" (the "active record" is the only record you are allowed to viEw at 
any one time) . 

3) Type: e to view [viEw] the "active record" . Press: ESC to browse other selected 
records. 

4) When you are finished viewing your records, press: ESC until you return to the Main 
Menu. 
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Addin Records to vour Database OS Ve sion 

STEP 1 : Open your Database 

1) From the Main Menu, type: d for Databases, then type: o fi r Open Database. 

2) Select your database and press: ENTER 

STl!P 1. : Adding a New Record 

1) At the Main Menu, type: e for Edit, Insert, View. A record n your database will appear. 

2) Type: w for setWorkform and the Workforms window wiU appear. 

3) Using the arrow keys, select the workform best suited for your ~ecord. • 

• When first selecting a worlif orm you may wish to use the f olli ing general guidelines: 

Information Source 

Book or Chapter 
in Book 
J oumal Article 
Report 
Dissertation or Thesis 
Conference Proceedings 
Memo or Letter 
Map 
Photogr · ,hs or Slides 
Video 
Audio Recording 
Computer File 
Unpublished Document 

I 
Preferred Pro-<Cite Workform 

A: Book - LoJ 
D: Journal .:. Stort 
E: Report 
G: Dissertation 
K: Conference I roceedings 
I: Letter I 
L: Map [ __ 
P: Audiovisual ~aterial 
Q: Video Recording 
N: Sound Recording 
T: Data File 
J: Manuscript 

4) Highlight the selected workform for your record and press: E~ TER 

5) Type: i for Insert to bring up a blank copy of your selected orkform. 
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6) Using the arrow keys, type in the infonnation for your record according to the conventions 
listed in the Guidelines for Entering Information handout. 

Step 3 : Saving your Record 

1) When you are finished typing in your record, press: Fl O to save your record (If you wish, 
use the Page Up and Page Down keys to scan your new record for any final changes or 
corrections. If corrections are needed, type: e for Edit and using the arrow keys type in 
your corrections. Press: FlO again to save your corrections). 

2) Press: ESC to return to the Main Menu. 

44 



) 

Editin Records in our Database DOS Ve ion 

SYlP 1 : Open your Database 

1) From the Main Menu, type: d for Databases, then type: o fa Open Database. 

2) Select your database and press: ENTER. 

STl!P l.: Editing a Record 

1) Using the Searching Pro-Cite handout find the record(s) you ·sh to edit, making sure 
that only the record(s) you wish to edit are "selected". Press: E C until you return to the 
Main Menu. 

2) At the Main Menu, type: e for Edit, Insert, View. A record in your database will appear. 

3) Either type: t for the next selected record [nexTsel] or type: for the previous selected 
record [preVsel] to locate the record(s) you wish to edit. 

4) Once you have found a selected record, type: e for Edit and sing the arrow keys, type in 
any changes to your selected record. 

5) When you are finished editing each selected record, press: FlO to save the changes. 

6) Press: ESC to return to the Main Menu. 
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Printing Bibliographies from Pro-Cite (DOS Version) 

STEP 1 : Open your Database 

1) From the Main Menu, type: d for Databases, then type: o for Open Database. 

2) Select your database and press: ENTER. 

STEP 1 : Select Records for your Bibliography 

For All Records in a Database 

1) At Main Menu type: s for 
Search Database. 

2) Type: a for Select All. 

3) Press: ESC and return 
to the Main Menu. 

4) At the Main Menu, you will 
see the number of records 
and the number of selected 
records at the top right­
hand comer. 

STl!P J : Order your Selected Records• 

For Selected Records in a Database 

1) At Main Menu type: s for Search 
Database. 

2) Type: a for Select All. 

3) Type: s for Search Selected 
Records. 

4) At the Search Expression window 
search the records you want to 
print out, following STEP 4- of 
the Searching Pro-Cite handout. 

5) Press: ESC until you return 
to the Main Menu. 

• Pro-Cite allows you to order your selected records, or citations, in a variety of ways. The 
most common are alphabetically by author, alphabetically by subject, or chronologically 
by date. 

1) At the Main Menu, type: i for Index, then type: s for Select Fields. The Fields ~r 
Index screen should appear with a list of all of the fields in Pro-Cite. · 
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2) Here is where you can choose how you want to order your citatio s: 

By Author 

Using the arrow keys, type: a 
to put an "A" beside each of 
the Auth fields (there are three 
in all) . 

By Subject 

Using the arrow keys, type: d 
to put a "D" beside the Desc 
field (found at the end of the 
right column). 

By Title 

Using the arrow k ys, type: t 
to put a "T" besid each of the 
Titl fields (there ! e three in all). 

By Date 

Using the arrow k ys, hit "t" 
to put a "T" besid~ the Date 
field (found in the · ddle column). 

3) When finished using one of the options above, press: FlO to sav . your option. 

S'll'E, 4: Format Your Bibliography 

1) Type: I for Layout Options for the Layout Options windo . 

2) At the Layout Options window, choose the type oflist"" you wish to produce by hitting 
the space bar to change the Produce selection. I 

*Produce Options: A) Subject bibliography producesla list of 

Produce Options 1, 
2 and 3 are commonly 
used when searching 
your database, while 
Option 4 is primarily 
used when inputting 
or editing records in 
your database. 

citations for a given subject or supjects. Your 
choice : · ordering your selected riecords 
becomes the type of subject bibli9graphy that is 
produced (e.g. ordering by author will produce 
list of citations by author). 

B) Subject list with record number produces 
a list of record numbers for a given subject or 
subjects. Again, your choice in o ,dering your 
selected records becomes the typf of subject 
list that is produced ( e.g. orderin~ by author 
will produce a list of record numoer(s) by 
author. 
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C) Subject list produces a list of the subjects you 
have ordered ( e.g. ordering by author produces a 
list of authors). 

D) Authority list produces a list of the subjects 
you have ordered and stores it internally in 
your database as an .IND file. 

3) Still at the Layout Options window, you can now make a number of further choices: 

A) Restart citation numbering for new entry Use the spacebar to determine whether 
your citations will be listed consecutively from the beginning of the list to the end [Yes] 
or whether the numbering will start over for each new section ( e.g. each new author, or 
title, or subject, or date depending on how you ordered them) [No]. 

B) Headhg style Use the spacebar to select the style for each section of your bibliogn.phy 
[Plain, Uppercase, Underline, and Uppercase and underlined]. 

C) Heading repetition Use the spacebar to determine whether each citation will have its 
own heading [With every citation] or just once, followed by the relevant citations 
[Once per group]. 

D) Word size Type in the number ofletters you want Pro-Cite to use in determining your 
selected order. For example, if you have ordered your citations by author and type 10 for 
your Word size, Pro-Cite will only look at the first 10 letters of authors' names in order 
to arrange them alphabetically. Some general guidelines for Word size are: 

a) When ordered by author or date, type 25. 

b) When ordered by subject, type 80. 

c) When ordered by title, type 150. 

4) When you are done selecting in the Layout Options window, press: FlO to save your 
options. 

5) Type: i for Index and Pro-Cite will start indexing (i.e. ordering) your selected records. 

6) When finished indexing, press: ESC to return to the Main Menu. 
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STIEP 5: Printing Your Bibliography 

1) Type: p for Print. The Print menu should appear. 

2) Type: o for Output, then press: ENTER Use the arrow keys t select an output option 
[Screen Preview, Printer, ASCII Text File, WordPerfect Doc ment, or Microsoft 
Word Document], then press: ENTER If you select ASCII Text File, WordPerfect 
Document, or Microsoft Word Document you will be prompted Enter name of output 
file when you print. Type the whole path for a word processing do ument (e.g. c:\wpdocs 
\authors.bet) or an ASCII text file (e.g. a:\authors.txt), then press: NTER 

3) Back at the Print menu use the arrow keys to explore other opti ns for the actual printing 
of your bibliography [Formatting Options, Page Layout, Field Options, and 
Numbering Options]. 

4) When you are finished selecting print format options, type: p to , rint your bibliography. 
Follow and answer any on-screen prompts as they appear. 

5) When Pro-Cite is finished printing, press: ESC to return to the am 
Menu. 

SYl!P 6: Clearing the Index 

1) If you are planning to exit Pro-Cite or search the database again, ou should clear the index. 
From the Main Menu, type: i for Index. The Index menu will ppear. 

2) Type: i again for Clear Index. 

3) At the Do you want to clear the INDEX? (YIN) prompt, type· y. Press: ESC to return 
to the Main Menu. 
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Starting Pro-Cite (Windows Version) 

STEP 1 : Opening Pro-Cite 

1) Beginning at Wmdows Program Manager, locate and double-click on the ProCite tile. The 
ProCite icon window should appear. 

2) In the ProCite icon window, double-click on the ProCite 3.1 icon. 

STIEP 2 : Opening your Database 

1) If your database has previously been opened, after double-clicking on the ProCite 3.1 icon 
your database will automatically open to Pro-Cite's Quick Search View screen and you are 
ready to begin any procedure. If, however, you are opening your database for the very first 
time, you will need to follow these steps: 

A) After double-clicking on the ProCite 3.1 icon, a blank ProCite 3.1 for Windows 
screen will appear. Select File for the file menu and click once. 

B) From the file menu, select Qpen ... and click once. The File Open dialog box will 
appear. 

C) From the File Open dialog box, double-click on database in the Directories: 
window and your database should appear in the larger File Name: window. 

D) Click once on your database and it should.~ppear in the upper window under File 
Name:. 

E) Once your database appears, click once on the OK button and your database will 
open to Pro-Cite's Quick Search View screen and you are now ready to begin any 
procedure. 

2) At the Quick Search View screen, you are now ready to begin using your Pro-Cite 
database. Follow the steps in the handouts for the particular procedure you wish to perform 
or consult the Pro-Cite manuals. 
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Exiting Pro-Cite (Windows Version) 

STEP 1 : Closing your Database 

1) From the Quick Search View screen, select file and click once. Th • file menu will 
appear. 

2) From the file menu, select E!)t and click once to close and save our database. The 
ProCite icon window will appear. 

STIP 2 : Exiting Pro-Cite 

1) Double-click on the B in the upper left-hand corner of the ProCite icon window to 
return to Windows Program Manager 
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Searching Pro-Cite (Windows Version) 

STEP 1 : Begin your Search 

1) From the Quick Search View screen, select View and click once. The View menu will 
appear. 

2) From the View menu, select ~earch and click once. The Search Expression screen will 
appear with a cursor (I) in the upper search window. (Ifthere is already a search expression 
there, highlight it by clicking once on the cursor and holding, while sliding the cursor over 
the search expression. Once the unwanted search expression is completely highlighted, 
press: DELETE) 

STEP 1 : A Basic Search 

1) At a blank Search Expression screen, click once on the Fields ... button and the Search 
Fields dialog box will appear. 

2) Select the Pro-Cite field you wish to search by clicking on the arrow buttons (rn or (!]) in 
the Search Fields dialog box and highlighting the field by clicking on it once. (Consult the 
Pro-Cite Workform Field Abbreviations handout for a description of each field and its 
field number) After highlighting the selected field, click once on the OK button. Your 
selected field will appear in the upper search window of the Search Expression screen. 

3) Click once on Operators... button and the Search Operators dialog box will appear. 
Following the brief descriptions of each operator, select an operator for your search by 
clicking on it once to highlight it, and then, clicking once on the OK button. Your selected 
search operator will appear in the upper search window of the Search Expression screen. 

4) Finally, click once on the Terms ... button and the Insert Tenn dialog box will appear. 
Click once on the 1iI button directly beneath the words "Insert Term" and a pull-down 
window of search fields will appear. 

5) Select the search field for your search and click on it once. A list of the searchable terms for 
that field will appear in the Term window. 

6) Using the arrow buttons (ll) or (j)) to move through the list, select the term you wish to 
search for by clicking on it once to highlight it. Click once on the Insert Term button and 
then once on the Close button. You will now be back at the Search Expression screen and 
your search term will have been inserted to complete your search expression. 
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7) When you are finished entering your search expression, click one on the Search button. 
Wait a moment, and Pro-Cite will display, by author, title and dat , the records which match 
your search expression in the lower search window of the Search Expression screen. 

STEP 3 : Viewing your Search R~sults 

I) To view any record that matched your search expression, double click on it in the lower 
search window. Wait a moment and the full record will appear. S roll through the record by 
clicking on the arrow buttons (HJ or@) on the far right of the Erit Record screen. 

2) When you are finished viewing a record and wish to view anothe, click on either the~ 
button (next record) or thee] button (previous record) to the ri 1ht of the Record 
Number: window. 

3) When you are finished viewing your selected records, return tot , e Search Expression 
screen by double-clicking on the E) button in the left-hand come of the Edit Record 
screen. 

4) At the Search Expression screen, select View and click on_ce. 

5) From the View menu, select Quick Search and click once to etum to the Quick Search 
View screen . 
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Adding Records to your Database {Windows Version) 

STEP 1: Opening a New Record 

1) From the Quick Search View, select Database and click once. The Database menu will 
appear.· 

2) Select New Record from the Database menu and click once. A blank Pro-Cite 
workform will appear. 

3) Before typing in the information for your record, you should select the proper workf orm for 
that information."' Click once on the lt) button to the left of Record Number: . A pull­
down list of Pro-Cite workforms will appear. 

"'When first selecting a workform you may wish to use the following general guidelines: 

Information Source 

Book 
Chapter in Book 
Journal Article 
Report 
Dissertation or Thesis 
Conference Proceedings 
Memo or Letter 
Map 
Photographs or Slides 
Video 
Audio Recording 
Computer File 
Unpublished Document 
Newspaper Clippings 

Pref erred Pro-Cite Workfr _~m 

Book, Long Form 
Book, Chapter 
Journal, Short Form 
Report 
Dissertation 
Conference Proceedings 
Letter (Correspondence) 
Map 
Audiovisual Material 
Video Recording 
Sound Recording 
Data File 
M:muscript 
Newspaper 

4) Click on the arrow keys(@ or HD to scroll through the workform list and select the 
workform for your record by clicking on it once. Wait a moment and a blank version of your 
selected workform will appear in the New Record window. 

5) Using the TAB keys to move between fields, type in the information for your record 
according to the conventions listed in the Guidelines for Entering In format~·'.!! handout. 
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.STEP Z : Saving your Record 

I) When you are finished typing in all the information for your record, ave your record by 
selecting Database and clicking once for the Database menu. 

2) From the Database menu, select .S,ave Record and click once. 

3) Back at the Search Expression screen, select File and click once fo the file menu. From 
the File menu, select Close and click once. 
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Editing Records in your Database {Windows Version) 

STEP 1 : Finding your Record 

1) From the Quick View Search screen, select the record(s) you wish to edit following 
STEPS 1 and 1 of the Searching Pro-Cite handout. 

2) Select the record you wish to edit by double-clicking on it in the lower search window of 
the Search Expression screen. 

STEP 2.: Editing a Record 

1) After double-clicking on the record you wish to edit, wait a moment and you should be in 
the Edit Record screen. Use your TAB key to move between the fields in the record and 
type in any changes to your record. 

2) When you are finished editing a record, double-click on the B button in the left-hand 
corner of the Edit Record line. The prompt: "Save Changes to database record?" will 
appear. Click once on the Yes button and your changes will be saved and you will return to 
the Search Expression screen. 

3) When you are finished editing your record(s), from the Search Expression screen, select 
View and click once for the View menu. 

4) From the View menu, select Quick Search and click once to return to the Quick Search 
View screen. 
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Printin Standard Biblio ra hies from Pro-Cite indows Version 

STEP 1 : Select Records for your Bibliography 

For All Records in a Database 

1) From the Quick Search 
View screen, select AU 
Records from the window 
in the upper left-hand 
section of the screen and 
click once. (If all records 
have already been selected 
nothing will happen) 

STEP '2 : Format your Bibliography 

For Selected Records in a Database 

I) From the Quick Se rch View 
screen, select Vie I and click 
once. 

2) From the View m nu, select 
S,earch and click o ce. 

3) At the Search Exp ession screen, 
follow ST!P '2 of he Searching 
Pro-Cite handout. 

1) From either the Quick View Search screen (all records) or the Searc Expression screen 
(selected records), select Bibliography and click once. The Biblio I raphy menu will 
appear. 

2) From the Bibliography menu, select frint Bibliography ... and t e Bibliography Setup 
screen will appear. 

3) Select the folder tab General and click once. In the General folder you can now make a 
number of choices: 

A) Items to Print allows you to select which records you want to rint. The default 
setting of All Records in List is the best choice, since it refers t 1 the records you are 
currently viewing (all records or selected records) 

B) Destination allows you to select where you want your bibliography printed. If you are 
sending your bibliography to Printe.r, when you select OK to print, you will be 
prompted to make choices regarding Print Range, Print Quali~ and Copies from a 
Print dialog box. From the Print dialog box, you should also Sf lect the ~etup ... 
button and click once. From the Print Setup dialog box, select ;your Printer, 
Orientation and Paper options. Click on the Qptions... butt?n to explore further 
printer setup options. If you are printing your bibliography to a ord Processor File , 
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when you select OK to print, you will be prompted with a Save As dialog box in 
which you must select the File Name:, Directories:, Dri~es:, and Save File as 
,Iype: (Word, WordPerfect and ASCII text) for your bibliography. 

C) Reference List Title will.print what you type into this box as the title for your 
bibliography. 

D) Reference List Order will determine the order in which your records will appear in 
your bibliography. The default order of Authorffitle/Date is most commonly used. 

E) Output Style will determine the bibliographic style used to format each record in your 
bibliography. 

4) Next, select the folder tab Reference and click once. In the Reference folder, you can 
select a number of record formatting options such as Font and Size, Indentation, 
Spacing, and Numbering of your records. 

5) Select the folder tab fields and click once. In the fields folder, you can modify the fields 
that will appear in your records. 

A) Optional Fields allows you to select additional fields not included in the bibliographic 
style selected in Output Style of the General folder. To include any of these fields in 
your records, select the box beside the item you wish to include and click once. An X 
should appear in the box indicating it will be included in your records. 

B) Short Form allows you to override the selected bibliographic style and select only 
those fields you wish to appear in your records." 

"The "Short Form" option should only be used when you require specific fields to 
appear in your records. If you do not want this option you must delete the "X" from the 
"Use Short Form" box, otherwise it will override your selected bibliographic style and 
produce records with only the selected fields. 

Use the Short Form option as follows: 

a) Select the box beside Use Short Form and click once. An X should appear in the 
box. 

b) Click once on the ~elect Fields... button and the Selected Fields dialog box will 
appear. 

c) Select the fields you wish to include in your records clicking on them once to 
highlight them, remembering that in the Short Form option only those fields you 
highlight will appear in your records (Consult the Pro-Cite Workform Field 
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Abbreviations handout for a description of each field, its i eld number and 
abbreviation). 

d) When you are finished highlighting the fields you wish incl de in your records click 
once on the OK button in the Selected Fields dialog bo . 

6) Select the folder tab fage and click once. In the Page folder y u can select page 
formatting options such as Margins and Page Numbers . Expe · ent with the different 
page formatting options by either typing them in or clicking once o remove or produce an 
X . 

STEP J : Printing your Bibliography 

I) When you are finished selecting all the Bibliography Setup opti ns in the General , 
Reference, fields, and fage folders, click once on the OK bu on and Pro-Cite will 
begin to print your bibliography. 

2) When Pro-Cite is finished printing, it will return you to the screen where you first selected 
Bibliography. If you printed all the records in your database, Pro- ite will return you to the 
Quick View Search screen. U: however, you printed only selected ecords and are at the 
Search Expression screen, select View and click once and the Vi~w menu will appear. 
From the View menu select Quick Search to return to the Quic Search View screen. 
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Printing Subject Bibliographies from Pro-Cite (Windows Version) 

STEP 1 : Select Records for your Subject Bibliography 

For All Records in a Database 

1) From the Quick Search 
View screen, select All 
Records from the window 
in the upper left-hand 
section of the screen and 
click once. (If all records 
have already been selected 
nothing will happen) 

STEP 1 : Format your Subject Bibliography 

For Selected Records in a Database 

1) From the Quick Search View 
screen, select View and click 
once. 

2) From the View menu, select 
~earch and click once. 

3) At the Search Expression screen, 
follow STEP 1 of the Searching 
Pro-Cite handout. 

1) From either the Quick View Search screen (all records) or the Search Expression screen 
(selected records), select Bibliography and click once. The Bibliography menu will 
appear. 

2) From the Bibliography menu, select P,rint Subject Bibliography ... and the 
Bibliography Setup screen will appear. 

3) Select the folder tab General and click once. In the General folder you can now make a 
number of choices: 

A) Items to Print allows you to select which records you want to print. The default 
setting of All Records in List is the best choice, since it refers to the records you are 
currently viewing ( all records or selected records) 

B) Destination allows you to select where you want your subject bibliography printed. If 
you are sending your subject bibliography to Printer, when you select OK to print, 
you will be prompted to make choices regarding Print Range, Print Quality and 
Copies from a Print dialog box. From the Print dialog box, you should also select 
the Setup... button and click once. From the Print Setup dialog box, select your 
Printer, Orientation and Paper options. Click on the Qptions... button to explore 
further printer setup options. If you are printing your subject bibliography to a Word 
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Processor File, when you select OK to print, you will be pr , mpted with a Save As 
dialog box in which you must select the File Name:, Directo ies:, Driyes:, and Save 
File as !Ype: (Word, WordPerfect and ASCII text) for your . ubject bibliography. 

C) Reference List Title will print what you type into this box a the title for your subject 
bibliography. 

D) Reference List Order will determine the order in which you records will appear in 
your subject bibliography. The default order of Authorffitl ate is most commonly 
used. 

E) Output Style will detemtlne the bibliographic style used to rmat each record in your 
subject bibliography. 

4) Next, select the folder tab Reference and click once. In the Re erence folder, you can 
select a number of record formatting options such as Font and j ize, Indentation, 
Spacing, and Numbering of your records. 

5) Select the folder tab Fields and click once. In the Fields folde , you can modify the fields 
that will appear in your records. 

A) Optional Fields allows you to select additional fields not in faded in the bibliographic 
style selected in Output Style of the General folder. To i~clude any of these fields in 
your records, select the box beside the item you wish to incluf e and click once. An X 
should appear in the box indicating it will be included in your ecords. 

B) Short Form allows you to override the selected bibliographi style and select only 
those fields you wish to appear in your records." 

* The "Short Form" option should only be used when you re ire specific fields to 
appear in your records. If you do not want this option you m st delete the "X" from the 
"Use Short Form" box, otherwise it will override your select1 d bibliographic style and 
produce records with only the selected fields. 

Use the Short Form option as follows: 

a) Select the box beside Use Short Form and click once. 
box. 

X should appear in the 

b) Click once on the ~elect Fields... button and the Select d Fields dialog box will 
appear. 

c) Select the fields you wish to include in your records clic · , g on them once to 
highlight them,

1
remembering that in the. Short Form optil n only those fields you 
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highlight will appear in your records (Consult the Pro-Cite Workform Field 
Abbreviations handout for a description of each field, its field number and 
abbreviation). 

d) When you are finished highlighting the fields you wish include in your records click 
once on the OK button in the Selected Fields dialog box. 

6) Select the folder tab fage and click once. In the Page folder you can select page 
formatting options such as Margins and Page Numbers. Experiment with the different 
page formatting options by either typing them in or clicking once to remove or produce an 
X. 

7) Finally, select the folder tab Terms and click once. In the Terms folder you can select a 
number of options specifically for subject bibliographies: 

A) Reference List options include ,S_ubject Terms Only which will print a list of the 
selected subject terms only, while ,S_ubject Terms and Reference List will print 
each selected subject term with the related records underneath. An X beside 
Reneating Subject Terms will print a subject term above each related record, while 
an X beside Regrcling Reference Numbers will repeat the numbering of records 
for each subject term. 

B) Include options provide for Subject Term Counts which will print the number of 
records containing the selected subject term beside or underneath that subject term, 
while List of Record Numbers will print the Pro-Cite record numbers of the records 
that contain the selected term beside or underneath that subject term. 

C) Subject Term Layout and Styles options have a number of print layout and 
printing options for your subject bibliography. Explore the options available by 
clicking once in the appropriate box to select an item with an X . 

STEP 3: Printing your Subject Bibliography 

1) When you are finished selecting all the Bibliography Setup options in the General, 
Reference, fields, fage and Terms folders, click once on the OK button and Pro­
Cite will begin to print your subject bibliography. 

2) When Pro-Cite is finir'i.ed printing, it will return you to the screen where you first selected 
Bibliography. If you printed all the records in your database, Pro-Cite will return you to the 
Quick View Search screen. U: however, you printed only selected records and are at the 
Search Expression screen, select View and click once and the View menu will appear. 
From the View menu select Quick Search to return to the Quick Search View screen. 
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National Park Service Natural Resource Database 

Subject scope of materials to be included: 

"All materials related to the natural resources of the park/monu 

"naturaul resources": flora, fauna, soil, air, water roe , and activities that 
affect them (i.e. mining, grazing, · or water 
pollutants, logging, farming, recr ational activities .. . ). 

"related to the park": resources within the park itself: o within the region (the 
region will vary, for example, the region for mammals/ 
birds/plants may be the valley or ·orest the park is in, while 
the region for geology might be a larger area which includes 
a given rock formation). 

Format scope of materials to be included: 

"Include any and all documents that convey significant and relev t information" 

"all documents": both print and non-print formats, pj lished and unpublished 
materials, including reports, books, jbumal articles, memos, 
field notes, maps, videos, specimen cbllections, slides, 
photographs, data files . 

Scope of materials not to be included: 

Documents which cover a very large region that goes well beyo d the park (i.e. the entire 
state), unless there is a section specific to the park, or entries in 

I 
e index for the park. 

Documents which describe a resource of the park (i.e. a certain ~ - al that lives there), 
but it isn't clear as to a specific location. · 

Documents which are for the general public and contain no pote tially new information 
(i.e. general subject matter that would be contained in document such as newspaper 
articles, pamphlets, and popular magazines articles). 

This database is not intended to be an inventory of the park's library collection. Instead 
this database should be the place where someone can find specific lnf ormation regarding the 
natural resources of the park itself To find more general information t~ey can consult the park's 
library or other larger library collections. There are a lot of gray ar:eas. Lean on the side of 
including documents if they seem relevant. Be especially generous with r.npublished materials that 
may not exist anywhere else, and more stingy with published materi that can be found in a 
typical university or public library collection. 
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Guidelines for Entering Information 

The following is an alphabetical list of the more common Pro-Cite fields you will encounter 
when entering and updating records in your database. Included in this list are the field 
abbreviations (for DOS version), field numbers, brief descriptions of the type of information you 
should enter and examples of how you should enter that information in each of the fields. 

Abstract [Abst] field # 43 : 

The abstract field is the place to provide specific infonnation about the subject matter 
contained in the document. Because of copyright restrictions it is not advisable to merely type in 
an author's abstract, but you may instead type in the table of contents or paraphrase the 
document's subject matter yourself. 

Author [Auth] fields# 1,7,16: 

There are three author fields in most Pro-Cite workforms: 

1) Author (Analytic) refers to the author of a section of a larger work 
( e.g. author of a chapter in a book or a single paper in a conference 
proceedings). 

2) Author (Monographic) refers to the author of a larger work 
as a whole (e.g. author of a book). 

3) Author (Subsidiary) refers to the author of a work whose 
contribution to that work is secondary to tha : of the principle 
author ( e.g. illustrator of a book). 

Enter author(s) as follows, using // to separate authors and = for 
organizations or titles: 

FORMAT: Last name, First name Middle name or initial 

EXAMPLES: Smith, John David//Jones, Robert M. 
Smith, John//Jones, R. 
Smith, J. D.//Jones, R. M 
Smith, John D.=Jr.//Jones, R.=Dr. 
=National Audubon Society 
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Call Number [Call) field# 44: 

The call number field is where you describe the location of the document. The call number 
should contain the field area code (for the Northeast Field Area this is NEFA~ for the National 
Capital Field Area this is NCFA), the four-letter park code, the park n me, and a brief description 
of the document's location. Enter the call number as follows: 

FORMAT: REGION CODE-PARK CODE I Description oflocati n 

EXAMPLES: NEFA-FONE / Fort Necessity National Battlefield, ark 
Headquarters, Administration files, file N32 

NCFA-SHEN I Shenandoah National Park, Mainte ance Building, 
Resource Specialist's Office, Gypsy Moth file 

If the document is held outside the park service, enter a descriptio of the document's location 
and any other relevant location information. 

EXAMPLES: NEF A-JOFL / Johnstown Museum, 1 Front Street, 1 ohnstown, PA 

NEFA-ALPO I National Railroad Association, 555- 212 

If a citation is found, but the location of the document is unknown, type: citation only, 
document not found and describe the location of the citation in then ! te field . 

EXAMPLE: NEF A-FRIIl / citation only, document not found 

Cartographer [Cart] field # 7 : \ 

Enter the name of the map maker(s) in the same way as the author eld. 

FORMAT: Last name, First name Middle name or initial 

EXAMPLES: Andrews, Charles Philip//Walters, Richard M. 
Andrews, C. P.//Walters, R 
Andrews, Charles P.=Jr.//Walters, R. M.=Dr. 
=Pennsylvania Geological Survey 

Date of Publication [Date] field# 20: 

The year is the most important element. Type in all four digits. i there is a span type out all 
four digits of both years with a hyphen between. You may add the month and day if they are 
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available. For documents with unknown dates guess and type it using a? . If you are unable to 
guess the date type: no date. If there is a collection of several items (e.g. photographs or 
newspaper clippings) you may use: various dates. Enter the date of publication as follows: 

FORMAT: Month day, year 

EXAMPLES: December 25, 1960 
December 1960 
1960 
1960-1961 
1960? 
196? 
no date 
various dates 

Date of Meeting [DtMt] field# 12 : 

This field is found in the Conference Proceedings workform. Enter information only if the date 
of meeting is known. Like date of publication, enter the date of meeting as follows: 

FORMAT: Month day(s), year 

EXAMPLES: December 20-25, 1960 
December 25, 1960 
December 1960 

Descriptors [Desc] field # 45 : 

There can be as many as 6 different types of information, each separated by a / , that can be 
included in this field. Some elements are mandatory while others are simply preferred: 

1) Record Number refers to the five-letter project code NRBIB: (i.e. 
Natural Resources Bibliography), followed by the four-letter park 
code and a four-digit record number. This is a mandatory element 
and appears as follows: 

FORMAT: Five-letter project code: four-digit park code - four-digit 
record number 

EXAMPLES: NRBIB: ALPO-0035 
NRBIB: FONE-0741 
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For the DOS version of Pro-Cite enter this element at the st t of the 
Descriptors [Desc]field In the Windmvs version of Pro-Cite nter this 
element at the start of the Notes [Note]field. 

2) Subject Term(s) refers to a general subject area for the docu ent, 
usually taken from the SUBJECT (DOS) or Keywords (Wi~dows) 
authority lists or the List of Subject Terms provided. You mfy use 
more than one subject for a document, separated by a/, but np more 
than two subject terms per document. This element is mandat ry and 
typed in uppercase letters as follows: 

FORMAT: capitalized SUBJECT TERM(S) 

EXAMPLES: GEOLOGY 
ECOLOGY~LANTSTUDIES 

3) Descriptor Tenn(s) refers to those terms which best describ 

1 

the subject matter of the document, usually taken from the 
existing DESC (DOS) or Keywords (Windows) authority lists, 
or the NPS Natural Resource Bibliography Thesaurus pro · ded. 
Try to list these mandatory terms in order from general to sp cific, 
separating each term by a / . 

FORMAT: descriptor term/descriptor term/descriptor 1frm 

EXAMPLES: animal behavior/grazing/sika deer (CenrJs nippon) 
water resource management/water qualit turbidity 

It is important that you use the most specific term(s) to d iscribe 
the document. There are two formats you should be aware o when 
typing in a descriptor not found in the DESC (DOS) or Ke ords 
(Windows) authority lists: 

A) If the descriptor is a name of a feature, follow the 
descriptor with the capitalized park or state abbrevia · on in 
parentheses: 

FORMAT: Name ofFeature, (capitalized STA or PARK 
abbreviation) 

EXAMPLES: Hazel River (SHEN) 
South Fork Dam (PA) 

If the descriptor is the name of a place, follow the pl ce 
name with the capitalized state abbreviation. 
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FORMAT: Place Name, capitalized STATE abbreviation 

EXAMPLES: Luray, VA 
Valley Forge, PA 

B) If the descriptor is a species, start with the common name 
followed by the genus or species name in parentheses: 

FORMAT: common name (scientific name) 

EXAMPLES: snakes (Serpentes) 
gypsy moth (Lymantria dispar) 

4) Document Type refers to the type of document. You may find an 
appropriate term in the DOCUMENT (DOS) or Keywords (Windows) 
authority lists, if not, you may.decide to omit this part of the 
descriptor field. 

FORMAT: document type 

EXAMPLES: annual report 
checklist 

5) Format Type refers to any formats which are included in the 
document or make up a substantial part of the document. 
Try to use only those terms present in the FORMAT (DOS) 
or Keywords (Windows) authority lists. If you fail to find a 
term that applies to your document, you may omit this field. 

FORMAT: format type 

EXAMPLES: map 
video cassette 

6) Geographic Area refers to the park(s) mentioned in the 
document. This element includes the park name(s) followed 
by the state abbreviation and should always be the final 
element in this field. 

FORMAT: Park Name, capitalized STATE abbreviation 

EXAMPLES: Catoctin Mountain Park, :MD 
Gettysburg National Military Park, PA 
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Finally, if when combining all 6 elements of the Descriptors [D sc] field for a given document, 
it should appear as one of the following: 

FORMAT: RECORD NUMBER/SUBJECT TERM(S)/descri , tor term(s)/document 
type/format type/Geographic Area 

EXAMPLES: NRBIB: GETT-0154/PLANT STUDIES/plant threatened and 
endangered species/checklist/Gettysburg Nation itary Park, PA 

NRBIB: SHEN-0008/AQUATIC STUDIES/hyd ology/water 
supply/water quality/Environmental Impact Stat ment (EIS)/ 
video cassette/Shenandoah National Park, VA 

Director [Dctr] field # 16 : 

Enter the name of the director of a video cassette in the same w y as the author field : 

FORMAT: Last name, First name Middle name or initial 

EXAMPLES: Sandburg, William Patrick 
Sandburg, William P. 
Sandburg, W. P. 
Sandburg, William P.=Jr. 

Distributor [Dist] field # 19 : 

If a distributor is listed on a video, list the name of the distribute , as it appears on the video. 

FORMAT: Distributor Name 

EXAMPLES: Nature Films America 
United Artists International 

Extent of Work [Extn] field# 26: 

This field represents the relative size of an item. For a documen enter the extent of the work 
as follows: 

FORMAT: numberofpages p. 

EXAMPLE: 135 p. 
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If the document has no page numbers, guess at the number of pages and include a + sign as 
follows: 

FORMAT: approximate number of pages + p. 

EXAMPLE: 45+ p. 

For other media use the appropriate descriptive term: 

FORMAT: number of item item description 

EXAMPLES: 24 slides 
3 maps 

Issue Number [IsID] field# 24 : 

Journals are generally published in volumes and then issues. Type in the issue number here by 
itself 

FORMAT: issue number 

EXAMPLE: 8 

Journal Title [Jrnl] field# 9 : 

This field appears in journal workforms. Enter the entire title of the journal as it appears on the 
document or citation, or use your best guess if the complete title is not clear: 

FORMAT: Title of Journal (as it appears) 

EXAMPLES: The American Society of Paleontology Bulletin 
Northeastern Wtldlife 

Letter to [Ltto] field # 10 : 

This field appears in the Letter workform only. Unlike the author field, enter the name of the 
individual the letter or memo is addressed to in normal order as it appears on the document: 

FORMAT: First name Middle name or initial Last Name 
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EXAMPLES: Daniel J. Booth 
Daniel James Booth 
Daniel Booth 

Location in work [Loe] field# 25 : 

This field is used when you are describing a portion of a docu ent rather than the entire 
document. For journal articles enter the span of pages as follows: 

FORMAT: first page - last page 

EXAMPLE: 231-245 

For books and reports enter the span of pages, preceded by: p., as ollows: 

FORMAT: p. first page - last page 

EXAMPLE: p. 231-245 

Notes [Note] field# 42: 

This is the place for comments about the document itself such as hysical condition, version, 
number of copies, misspellings, and if you are entering a citation and \have not found the actual 
document, enter the title of the document where you found the c~· t tion. If you are entering 
information in the Windows version of Pro-Cite begin this field with the four-letter park code, 
followed by a four digit record number (see Record Number in the escriptors field). Separate 
each item of information with a ; as follows: 

EXAMPLES: front cover missing; draft version; three copies 
citation found in "Pennsylvania Wildlife" (1992) by D. Fisher 
final version; "Ecology" misspelled in title 

Packaging Method [PaMe] field # 27 : 

This field is the place to enter information regarding the type of fo at for video cassettes: 

FORMAT: VIDEOA1EDIA FORMAT 

EXAMPLES: VHS 
BETA 
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Paper Title [Papr] field # 4 : 

This field is found in the Conference Proceedings workform. Enter the title of the paper within 
the conference proceeding as it appears on the item and follow the rules for titles. 

FORMAT: Title of paper (as it appears) 

EXAMPLE: Gypsy Moth Infestation at Shenandoah National Park 

Place of Meeting [PIMt] field # 13 : 

For conference proceedings the meeting location is entered here. Enter the place followed by 
the state abbreviation. 

FORMAT: City, capitalized STATE abbreviation 

EXAMPLE: Valley Forge, PA 
Sharpsburg, :MD 

Place of Publication [PIPb] field # 18 : 

Enter the place of publication here including the city and state abbreviation or, when outside 
the United States, the country abbreviation. 

FORMAT: city, capitalized STATE abbreviation or COUNTRY abbreviation 

EXAMPLES: Washington, DC 
Toronto, CN 

Producer [Prod] field # 7 : 

If a producer is listed for a video, enter the name of the individual here in the same form as the 
author field. 

FORMAT: Last name, First name Middle name or initial 

EXAMPLES: Davis, Anthony James 
Davis, Anthony J. 
Davis, A. J.=Dr. 
=Audubon Society of Maryland 
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Publisher [Puhl] field # 19 : 

This is the place for the name(s) of the person(s} and/or organiza on(s) involved in producing 
the item. If there is more than one person or organization involved, s~ arate each with an and . 

FORMAT: Name of Publisher (as it appears) 

EXAMPLES: Steven Howe Publishers 
Steven Howe Publishers and Northwest Publishers 
Steven Howe and Chris Squires 

Report Identifier [RplD] field # 23 : 

Enter here report numbers, as they appear on the document ( th re may be more than one). 
Include any words that accompany the number. 

FORMAT: any combination of words, letters and/or numbers 

EXAMPLES: 85-001-25 
USGS 96-23167 
Technical Report VT-0023 

Scale [Seal] field # 29 : 

This field appears in the Map workform. Type the scale of the ma as it is shown on the map. 

FORMAT: number: number 

EXAMPLE: 1 : 2400 

Section Title [Sect] field # 4 : 

In the Report workform, this is where you enter the title of a se

1
ction of a report (if you are 

describing only that section rather than the report as a whole). Fo ow the same format as the 
Title field. 

FORMAT: Title of Section (as it appears) 

EXAMPLE: Deer Habitat in Pennsylvania 
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Series Title [SrTi] field # 32 : 

A "series title" is an overall title for a collection of documents published as a series. Enter this 
using the same format as the Title field. 

FORMAT: Series Title (as it appears) 

EXAMPLE: Water Resources Investigative Reports 

Size [Size] field # 28 : 

This refers to the physical size of an item (e.g. map, photographs). 

FORMAT: width x length 

EXAMPLE: 24 x 32 

Title [Titl] fields# 4,9, 11 : 

There are two primary title fields in some Pro-Cite workforms: 

1) Title (Analytic) refers to the title of a section of a larger work 
( e.g. title of a book chapter or a single paper in a conference 
proceedings). 

2) Title (Monographic) refers to the title of a larger work as a 
whole ( e.g. title of a book). 

Enter the title the way it appears on the document. If the you are not sure what the exact title 
is or there is no title, do your best to create an appropriate one. If there are several titles, choose 
the one that seems most official. 

FORMAT: Title (as it appears) 

EXAMPLES: Vegetation study for Gettysburg National Military Park 
Behavioral ecology of black bears in the Shenandoah Valley 

University [Univ] field# 19: 

In the Dissertation workfonn, this where you enter the entire name of the university at which 
the dissertation was received. Include the name of the department if available. 
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) 

1-

FORMAT: Name of University, Name of Department 

EXAMPLES: The Pennsylvania State University, School of Forest Resources 
St. John's University, Department of Environmental cience 

Volume Number [VoID] field# 22: 

Journals are generally published in volumes and then issues. Type· the volume number here 
by itself 

FORMAT: volume number 

EXAMPLE: 103 
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FIELD 
NO. 

1 

2 

3 
4 

5 

6 
7 

8 

9 

Pro-Cite Workform Field Abbreviations (DOS Version) 

FIELD 
ABBR 

Auth 

Arts 

Comp 
AuRo 

CoRo 

ArRo 
Affi 
Titl 

Sect 

Papr 
Medm 

CoPh 
Auth 

Edtr 

Cart 

Prod 
AuRo 

EdRo 

CaRo 

PrRo 
Titl 

FIELD 
DESCRIPTION 

Author (Analytic)* or Catalog Author 
or 

Artist 
or 

Composer 
Author Role (Analytic)• 

or 
Composer Role 

or 
Artist Role 
Author Affiliation (Analytic)• 
Title (Analytic)• or Article Title or 
Catalog Title or Map Title or Program 
Title 

or 
Section Title 

or 
Paper Title 
Medium Designator or Data File or 
Medium or Computer Program 
Connective Phrase 
Author (Monographic )• • or 
Programmer 

or 
Editor/Compiler 

or 
Cartographer 

or 
Producer 

• Analytic = Section or 
Part of a 
Larger Work 

Author Role (Monographic ) 0 

or 

0 Monographic = Larger 
Work as 

Editor/Compiler Role 
or 

Cartographer Role 
or 

Producer Role 
Title (Monographic)•• or Collection 
Title or Proceedings Title or Report 
Title or Recording Title or 
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FIELD FIELD FIELD 
NO. ABBR. DESCRIPTION 

Jrnl J oumal Title 
10 Ltto Letter To 
11 Titl . Title 

or 
News Newspaper Title 

12 DtMt Date of Meeting 
13 PIMt Place of Meeting 
14 ;· Iedm Medium Designator 
15 Edit Edition 

or 
Vers Version 

16 Auth Author (Subsidiary) 0
"" """""" Subsidiary = Added 

or Features 
Perf Performer or 

or Elements 
Dctr Director ofa Work 

17 AuRo Author Role (Subsidiary)"""""" 
or 

PeRo Performer Role 
or 

DcRo Director Role 
18 PlPu Place of Publication 
19 Puhl Publisher Name 

or 
Univ University 

or 
Dist Distributor 

20 Date Date of Publication or Date of Lett r 
21 Copy Date of Copyright 
22 VoID Volume Identification 

or 
Sect Section ofNewspaper 

or 
CtNo Catalog Number 

or 
AqNo Acquisition Number 

23 RpID Report Identification 
or 

MxNo Matrix Number 
24 IsID Issue Identification 

or 
PtNo Plate Number 
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FIELD FIELD FIELD 
NO. ABBR DESCRIPTION 

25 Loe Location in Work 
26 Extn Extent of Work or Extent 

of Letter 
or 

Time Timing 
27 PaMe Packing Method 
28 Size Size of Work 
29 Seal Scale 

or 
RpRt Reproduction Rate 

30 SrEd Series Editor 
31 SrRo Series Editor Role 
32 SrTi Series Title 
33 SrVo Series Volume Identification 
34 Srls Series Issue Identification 
35 DeTy Document Type 
36 CoPh Connective Phrase 
37 Aval Availability 
38 StLo Storage Location 

· 39 CODN CODEN 
40 ISSN International Standard Serial Number 
41 ISBN International Standard Book Number 
42 Note Notes 
43 Abst Abstract 
44 Call Call Numbers 
45 Desc Descriptors 
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Pro-Cite Workform Field Abbreviations 

FIELD 
NO. 

(01) 

(02) 

(03) 

(04) 

(05) 

(06) 

(07) 

(08) 

(09) 

(10) 

(11) 

(12) 

(13) 

FIELD 
DESCRIPTION 

Author (Analytic)lll or Catalog Autho, 
or Artist or Composer 

Author Role (Analytic)" or Compose "'Analytic = Section or 
Role or Artist Role Part of a 

Larger Work 
Author Affiliation (Analytic)"' 

Title (Analytic)"' or Article Title or 
Catalog Title or Map Title or Progr 
Title or Title/Subject or Section Title 
or Paper Title 

Medium Designator or Medium, Data 
File or Computer Program or Map T~ e 

Connective Phrase 

Author (Monographic)"'"' or 
Author/Programmer or Editor/ 
Compiler or Cartographer or 
Producer 

Author Role (Monographic)*"' lll ~Monographic = Larger 
Work as or Editor/Compiler Role or 

Cartographer Role or Producer Role 

Title (Monographic)llllll or Collection 
Title or Proceedings Title or Report 
Title or Recording Title or Journal Title 

Letter To 

Title or Newspaper Name or Translat d 
Title 

Date of Meeting 

Place of Meeting or Area 
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FIELD FIELD 
NO. DESCRIPTIO:.J 

(14) Medium Designator 

(15) Edition or Version 

(16) Author (Subsidiary)""u or Performer u 11 Subsidiary = Added 
Features 

(17) Author Role (Subsidiary)*** or ofa 
Performer Role or Director Role Work 

(18) Place of Publication 

(19) Publisher Name or University or 
Distributor 

(20) Date of Publication or Date of 
Letter 

(21) Date of Copyright or Original 
Publication Date 

(22) Volume Identification l :- Section or 
Catalog Number or Acquisition 
Number 

(23) Report Identification or Matrix 
Number 

(24) Issue Identification or Plate Number or 
Column Number 

(25) Location in Work or Page(s) 

(26) Extent of Work or Extent of Letter or 
Timing 

(27) Packaging Method 

(28) Size of Work 

(29) Scale or Frequency of Publication 
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FIELD FIELD 
NO. DESCRIPTION 

(30) Series Editor 

(31) Series Editor Role 

(32) Series Title 

(33) Series Volume Identification 

(34) Series Issue Identification 

(35) Documeny Type or Language 

(36) Connective Phrase 

(37) Availability 

(38) Storage Location 

(39) CODEN 

(40) 
I 

International Standard Serial Num er 

(41) International Standard Book Number 

I 
(42) Notes 

(43) Abstract 

(44) Call Number 

(45) Keywords 
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NPS Natural Resource Bibliography: List of SUBJECT Terms 

ANIMAL STUDIES 

AQUATIC STUDIES 

ARCHEOLOGY 

ATMOSPHERIC SCIENCES 

ECOLOGY 

ETHNOLOGY 

GEOGRAPHY 

GEOLOGY 

IDSTORY 

MANAGEJ\.1ENT 

PALEONTOLOGY 

PLANT STUDIES 

RECREATION 
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) 

aerial photographs 

artifacts 

audio recording 

computer disk 

computer file 

computer print-out 

filmstrip 

infrared photographs 

LANDSAT images 

map 

microfiche and microfilm 

photographs 

questionnaires 

slides 

specunens 

transparencies 

video cassette 
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NPS Natural Resource Bibliography: List of DOCUMENT Terms 

annual report 

bibliography 

checklist· 

database 

diaries and journals 

directory 

environmental assessment 

Environmental Impact Statement (EIS) 

field notes 

guidebook 

handbook 

interpretive document 

laws and legislation 

legal documents 

manual 

newspaper clippings 

oral history 

plan 

research proposal 

research report 

survey 

84 



Appendix C 

List of Authoritative Sources for Scientific and Comm n Names 

flilll1S 
USDA Plants database: http://trident.ftc.nrcs.usda.gov/plants/plntmenu. tml 

National Plan Germplasm System: http://www.ars-grin.gov/npgs/ 

A field guide to eastern trees. George A. Petrides. Houghton Mifflin Co pany, New York. 
(1988) 

vertebrates 
Checklist of vertebrates of the United States, the U.S. Trust Territories d Canada. Richard C. 
Banks, Roy M. McDiarmid, Alfred L. Gardner. US Fish and Wildlife S ice Resource 
Publication 166, 79 p. ( 1987) 

Fish and Wildlife Reference Service: http·//www fws gov/search/fwrefser html . . . I . 

~ 
Check list of North American birds, sixth edition. American Ornithologists' Union Committee 
on Classification and Nomenclature. American Ornithologists' Union, 877 p. (1983) 

Thirty-seventh supplement to the American Ornithologists' Union check ist of North American 
birds, Auk 106: 532-538. (1989) 

A complete list of the birds of the world. Richard Howard and Alick Mo , re. Harcourt Brace 
Jovanovich, New York. ( 1991) 

A field guide to eastern birds. Roger Tory Peterson and Virginia Marie eterson. Houghton 
Mif:(lin Company, New York. (1980) 

Mammals \ 
Revised checklist of North American mammals north of Mexico, 1991. 1j·K. Jones, Jr, R.S. 
Hoffmann, D. W. Rice, C. Jones, R. F., Baker, M.G. Engstrom. Occasional Papers of the 
Museum, Texas Tech University 146, 23 p. (1992) 1 

A world list of mammalian species. G. B. Corbet and J.E. Hill. Cornell niversity Press, 
Ithaca, NY. (1980) 
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Reptiles and Amphibians 
Catalogue of American amphibians and reptiles, 1-100. American Society of Ichthyologists and 
Herpetologists, Herpetological Catalogue Committee 
1963-1970. American Society of Ichthyologists and Herpetologists. 

Standard common and current scientific names for North American amphibians and reptiles, 
third edition. Joseph T. Collins. Society for the Study of Amphibians and Reptiles 
Herpetological Circular 19, 41 p. ( 1990) 

A field guide to reptiles and amphibians: Eastern and Central North America. · Roger Conant and 
Joseph T. Collins. Houghton Mifflin Company, New York. (1991) 

Fishes 
Common and scientific names of fishes from the United States and Canada, fifth edition. 
American Fisheries Society, Special Publication 20. 

National Audubon Society field guide to North American fishes, whales, and dolphins. Herbert 
T. Boschung, Jr., James D. Williams, Daniel W. Gotshell, David K. Caldwell, and Melba C. 
Caldwell. Alfred A. Knopf, New York. ( 1994) 

Freshwater Invertebrates 
Freshwater invertebrates of the United States. Robert W. Pennak. John Wiley & Sons, New 
York. 803 p. ( 1979) 

Mollusks 
Common and scientifc names of aquatic invertebrates from the United States and Canada: 
mollusks. Donna D. Turgeon, Arthur E. Bogan, Eugene V. Coan, William K. Emerson, William 
G. Lyons, William L. Pratt, Clyde F.E. Rober, Amelie Scheltema, Fred G. Thompson and James 
D. Williams. American Fisheries Society Special Publication 16, 277 p. (1988) 

Insects and Arthropods 
Common names of insects & related organisms. Floyd G. Werner. Entomological Society of 
America, College Park, MD, 132 p. (1989) 

American insects: a handbook of the insects of America north of Mexico. Ross H. Arnett, Jr. 
(1985) 

An introduction to the aquatic insects of North America, 1984. R.W. Merritt and K.W. Cumins, 
eds. in An introduction to the study of insects. Donald J. Borror, C.A. Triplehorn, N.F. Johnson. 
Sanders College Publishing, Philadelphia. (1989) 
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National Audubon Society field guide to North American insects and s iders. Lorus Milne and 
Margery Milne. Alfred A. Knopf, New York. (1994) 

Butterflies 
The common names of North American butterflies. Jacqueline Y. Mille . Smithsonian 
Institution Press, Washington DC, 177 p. (1992) 

. Decapod Crustaceans 
Common and scientific names of aquatic invertebrates from the United tates and Canada: 
decapod crustaceans. A.B. Williams, I.G. Abele, D.L. Felder, H.H. Hob s, Jr. , R.B. Manning, 
P.A. McLaughlin, and I. Perez Farfante. American Fisheries Society Special Publication 17, 77 
p. (1989) 
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